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Conventions Used in this Guide
In this user guide, the following are used:

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

CAUTION:	 A caution indicates a potential hazard to equipment or data.

Commands are written in the fonts shown here: 
^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” 
represents the capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.

Click the OK button.

Copyright
© 2011  Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
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Introduction

This section gives an overview of the guide and features of the Quantum™ Elite Control 
Software and Quantum Connect Control Software. Topics that are covered include:

zz About this Guide

zz Overview of the Quantum Control Software

About this Guide
This guide provides detailed information about the Quantum Elite Control Software and 
Quantum Connect Control Software, including software installation and configuration. This 
guide also details how these applications control the Quantum Elite and Quantum Connect 
videowall processors.

The features and functionality described in this guide are based on using version 1.60s of the 
applications with Quantum Elite and Quantum Connect firmware version 7.12 and later.

For the latest details on firmware and software, visit www.extron.com.

Within this guide, the term “Quantum Control Software” refers to both the Quantum Elite 
Control Software and Quantum Connect Control Software. The term “Quantum processor” 
refers to both the Quantum Elite and Quantum Connect videowall processors. Notes 
distinguish where features differ between the Quantum Elite Control Software,  
Quantum Connect Control Software, Quantum Elite processor, and Quantum Connect 
processor. 

Overview of the Quantum Control Software
Quantum Elite Control Software and Quantum Connect Control Software are Microsoft® 
Windows®-based applications that are used to control the Quantum Elite and Quantum 
Connect videowall processors. These products form part of the Extron Quantum offering.

Using the Quantum Control Software, the Quantum Elite and Quantum Connect can display 
multiple image sources on a single target display or multiple target displays. External analog 
video sources (such as PAL, NTSC, or SECAM formats) and external analog and digital 
graphics sources are supported. The Quantum Elite and Quantum Connect also support the 
use of internal or network-based image files (such as BMP, JPG, GIF, or PNG formats) or RGB 
computer graphics captured using the QGE 100 Quantum Graphics Encoder.

The feature set supported by the Quantum Elite Control Software differs slightly from the 
Quantum Connect Control Software. These differences are distinguished in this user guide. 

NOTE:	 Quantum Elite Control Software does not operate with a Quantum Connect 
processor or vice versa.
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Features

Features of the Quantum Control Software include:

zz The user interface is organized into a series of tasks so that you can easily navigate 
through them and set up the videowall.

zz A virtual canvas provides an on-screen layout for the videowall where windows can be 
added, sized, and positioned.

zz Custom videowall configurations can be saved as window presets for future recall.

zz The software lets you create a custom user interface so that the system operator can 
easily recall the presets. 

Scene control

Each source is displayed in a resizable window within the Quantum Control Software, 
allowing multiple sources to be placed in any position on the display.

The Quantum Control Software uses “scenes” to store different source layouts on the 
display, including the size, position, and contents of one or more windows. Scenes can be 
recalled in any order using a customizable user interface or in a predefined order at specific 
time intervals using the the Auto Play function (see “Creating a Presentation” and 
“Viewing a Presentation”).

Scenes can also be recalled remotely via RS-232 (see “Serial Commands”).
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Installation and 
Operation

This section describes the software installation and communication setup in order to use 
the Quantum Control Software. The operation of the Quantum Control Software is also 
described. Topics that are covered include:

zz Requirements

zz Software Installation

zz Configuring the Hardware

zz Using the Quantum Control Software

Requirements

System Requirements

To ensure that the Quantum Control Software functions correctly and reliably, it must be 
installed on a computer that meets or exceeds the following criteria:

Minimum Recommended

Operating System Windows NT4 (SP6) Windows 2000,  
Windows XP or Windows 7 
(32-bit or 64-bit)

Processor Speed 200 MHz 450 MHz or higher

Memory (RAM) 64 MB 128 MB or higher

Hard Disk Free Space 30 MB More than 30 MB

Graphics 1024x768, 65K colors  
(16-bit)

1024x768, 16.7M colors 
(32-bit)

Network Card (Ethernet) 10BASE-T 100BASE-T
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Network Requirements

The Quantum Elite and Quantum Connect use specific network ports for communication. 
Ensure that these ports are accessible. 

Quantum Elite 

The Quantum Elite uses the following port numbers:

Port Number Use

Control

1237 Quantum discovery (UDP)

7004 System configuration (TCP)

7005 Scene control (TCP)

7006 System events (TCP)

Media I and Media 2

5000 Multicast reception of QGE 100 data  
stream (UDP)

37533 QGE 100 discovery (UDP)

37532 Reception of QGE 100 data stream (TCP)

Quantum Connect 

The Quantum Connect uses the following port numbers:

Port Number Use

Control

1238 Quantum discovery (UDP)

7007 System configuration (TCP)

7008 Scene control (TCP)

7006 System events (TCP)

Image Processing Hardware

The Quantum Control Software is used in conjunction with a Quantum Elite or Quantum 
Connect videowall processor.

Quantum Elite hardware comprises of a 4U or 6U card frame into which various input and 
output cards are installed.

NOTE:	 The Quantum Connect is available as a 4U frame.

See the Quantum User Guide for more information about the Quantum Elite and Quantum 
Connect, including connector pinouts and processing capability.

Except for defining an IP address, it is not necessary to perform any setup procedures on 
the Quantum Elite or Quantum Connect. System configuration is achieved through the 
Quantum Control Software.
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Software Installation
To install the Quantum Control Software from the Extron Videowall Processing disc:

1.	 Insert the Extron Videowall Processing disc into the appropriate CD or DVD disk drive of 
your PC.

2.	 From the Windows desktop, open My Computer and select the appropriate disk drive.

3.	 Open the Quantum Connect or the Quantum Elite folder, depending on your device. 

4.	 Open the Quantum Connect Software subfolder (for the Quantum Connect) or the 
Quantum Elite Software subfolder (for the Quantum Elite).

5.	 Run the Quantum Connect_Setupvx.xxx.exe file (for the Quantum Connect) or the 
Quantum Elite_Setupvx.xxx.exe file (for the Quantum Elite).

6.	 Follow the remaining system prompts to complete the installation.

Configuring the Hardware

Connecting to a Quantum Elite or Quantum Connect

The computer with the installed Quantum Control Software communicates with a Quantum 
Elite or Quantum Connect via Ethernet. This can either be a direct or indirect connection as 
shown in figure 1. Connection to a single videowall processor can use either method, but 
multiple videowall processors must use the indirect method (for example, via a hub).

A direct connection uses a single cable that is connected between the network port of the 
computer and the Quantum Elite or Quantum Connect (see figure 1a). You must use a 
crossover cable. A straight-through cable does not work. The network port on the computer 
must be capable of supporting a 10BASE-T connection as required by the Quantum Elite and 
Quantum Connect.

An indirect connection is made via a hub, switch or local area network, using a  
straight-through cable (see figure 1b). A crossover cable does not work. The hub or switch 
connected to the computer must be capable of supporting a 10BASE-T connection as 
required by the Quantum Elite and Quantum Connect.

Extron recommends using only CAT 5 shielded twisted pair cables. A 16-foot crossover cable 
is supplied with the Quantum Elite and Quantum Connect processors. 

See the Quantum User Guide for further details on cable requirements and connector 
pinouts.
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Ethernet 10BASE-T

Crossover Cable

Control Port

Quantum Elite
Processor
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to Control Source Switchers
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Quantum Elite 
Control Software
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 Cable

Control Port
Other Quantum Elite Processors

or Network Sources/Devices

Quantum Elite
Processor

Optional RS-232 Link
to Control Source Switchers

RS-232

HUB

Quantum Elite
Control Software

a. Direct Connection

b. Indirect Connection

Figure 1.	 Methods of Connecting the Quantum Elite Control Software Computer 
to a Quantum Elite Processor

Configuring the IP Address of the Computer

The network port on the computer must be configured to use the same communications 
protocol as the Quantum Elite or Quantum Connect, which is TCP/IP. The computer must 
also be allocated an IP address on the same subnet as the Quantum Elite or  
Quantum Connect (see “IP Addressing”).

If the computer is already connected to (and configured for) an existing network, consult the 
network administrator before making any changes. In addition, you need to be logged on 
with administrative rights before you can change Windows network settings.
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Setting the computer IP address

To set the IP address using Windows XP and Windows 2000:

1.	 Click the Windows Start button, right-click the My Network Places icon and select 
Properties from the drop-down menu. The Network Connections window opens.

- or -

For Windows 2000:

Right-click the My Network Places icon on the desktop and select Properties from 
the drop-down menu. The Network & Dial-up Connections window opens.

2.	 Right-click the Local Area Connection icon and select Properties from the  
drop-down menu. The Local Area Connection Properties dialog box opens.

3.	 In the list of loaded components, double-click Internet Protocol (TCP/IP). The 
Internet Protocol (TCP/IP) Properties dialog box opens.

4.	 Click Use the following IP address and enter the required IP address and subnet 
mask (see “IP Addressing”).

NOTE:	 If preferred, you can change the IP address of the Quantum Elite or 
Quantum Connect to suit that of the computer.

5.	 Click OK to execute the changes or click Cancel to retain the existing settings.

6.	 Restart the computer for the changes to become effective.

To set the IP address using Windows NT:

1.	 Right-click the Network Neighborhood icon on the Windows desktop and select 
Properties from the drop-down menu. The Network dialog box opens.

2.	 Select the Protocols tab.

3.	 In the Network Protocols list, double-click TCP/IP Protocol. The TCP/IP Properties 
dialog box opens.

4.	 Select the IP Address tab.

5.	 Click Specify an IP Address and enter the required IP address and subnet mask (see 
“IP Addressing”).

NOTE:	 If preferred, you can change the IP address of the Quantum Elite or 
Quantum Connect to suit that of the computer.

6.	 Click OK to execute the changes or click Cancel to retain the existing settings.

7.	 Restart the computer for the changes to become effective.
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Testing the Ethernet link

To test the operation of the Ethernet link between the computer and the Quantum Connect 
or Quantum Elite, you can use the Ping utility.

1.	 From the desktop, click Start > Run. The Run dialog box opens.

2.	 In the Run dialog box, type the following command: 
ping xxx.xxx.xxx.xxx —t 
where xxx.xxx.xxx.xxx is the IP address of the Quantum Elite or Quantum Connect 
that you want to test.

3.	 Click OK or press the <Enter> key on your keyboard. A text box opens showing a series 
of messages, which are explained below.

4.	 To stop the ping utility, press <Ctrl + C> on your keyboard.

When you run the Ping utility, it displays a series of response messages, which you can use 
to determine the state of the communications link.

zz For example, if you send a ping command to a Quantum Elite or Quantum Connect with 
the address 208.132.180.48, you should get a message similar to the following: 
Reply from 208.132.180.48: bytes=32 times=2ms TTL=32 
This is the correct response which indicates that the device at the specified address is 
communicating directly. The response time value may vary according to network traffic.

zz If you get the following message: 
Request timed out. 
this indicates that there has been no response from the specified address. Either the 
videowall processor is not receiving data from the computer or not sending data back. 
Check that the Quantum Elite or Quantum Connect is powered up and set to the same 
address to which you sent the ping command. Also, check that you are using the correct 
type of connecting cables (straight-through or crossover) and that they are not damaged 
or faulty.

zz If you get the following message: 
Reply from 208.132.180.48: Destination host unreachable. 
this indicates that the IP address of the computer is not in the same class as that of the 
Quantum Elite or Quantum Connect (see “IP Addressing”).

Using the Quantum Control Software

Running and Exiting the Quantum Control Software

You can run the Quantum Control Software using any of the following methods:

zz Double-click the Quantum Elite or Quantum Connect icon on the desktop.

zz From the desktop, click Start > All Programs > Extron Electronics >  
Quantum Elite (or Quantum Connect).

zz Double-click a presentation file (file name has a .ctp extension) in Windows Explorer.

If the Access Control feature has been enabled, a Login dialog box is displayed. You need to 
select an appropriate role and enter a password (see “Access Control”).

The Quantum Control Software splash screen appears for a few seconds followed by the 
main application window (see “Main Application Window”). 
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You can exit the Quantum Control Software using any of the following methods:

zz From the File menu, select Exit.

zz Click the  button at the top right corner of the application window.

zz Double-click the  icon in the top left corner of the application window, or  
single-click the same icon and select Close from the drop-down menu.

If you have not saved your presentation, a message is displayed asking whether you want to 
save any changes. 

Main Application Window

The Quantum Control Software application window comprises of the following elements 
(see figure 2):

zz Title bar

zz Menu bar

zz Toolbars

zz Taskbar

zz Workspace

zz Status bar

Figure 2.	 Elements of the Main Application Window
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Title bar — Shows the name of the currently loaded presentation

Menu bar — Provides a selection of drop-down menus to access various functions in  
the Quantum Control Software. Most of the menu functions can also be performed by 
buttons on the toolbars. The available menus change according to which task is currently 
selected in the taskbar.

Toolbars — The various toolbars within the Quantum Control Software allow quick access 
to the most commonly used functions within the currently selected task. Most of these 
functions can also be performed using the menu bar. To hide or show a toolbar for the 
current task, open the View menu and select the desired toolbar. A check mark beside the 
menu option denotes that the toolbar is open in the application. You can also click and drag 
open toolbars to rearrange them in the application window. 

Taskbar — Each major task within the Quantum Control Software is represented by an icon 
in the taskbar. To select a task, click the appropriate button. This displays the workspace, 
menus, and toolbars associated with the selected task.

The standard set of tasks includes (fewer tasks may be displayed depending on security 
settings):

zz Choose Display Processors

zz Choose Layout

zz Communications Setup

zz Set Up Sources

zz Scene Design

zz Scene Control

zz Remote Access Setup

Workspace — Each task in the taskbar has its own workspace. The workspace contains the 
controls and functionality needed to complete the task.

Status bar — Shows information about the current status of the Quantum Control 
Software. From the View menu, select Status Bar to hide or show the status bar.

Starting a New Presentation

When you run the Quantum Control Software for the first time after installation, a new 
untitled presentation is created with no system configuration settings.

Thereafter, there are two methods of starting a new untitled presentation depending on 
whether you want to:

zz Retain the existing system configuration (for example, to make a new presentation for 
the same system). 

zz Create a completely new presentation with no system configuration (for example, to 
make a new presentation for a different system).

To give your untitled presentation a name, you need to save it as described in “Saving a 
Presentation.”

Quantum Control Software • Installation and Operation 10



To retain the existing system configuration, choose one of the following methods:

zz Click the  button on the main toolbar. 

zz From the File menu, select New.

zz Press <Ctrl + N> on the keyboard.

To create a completely new presentation:

1.	 Exit the Quantum Control Software by following the instructions in  
“Running and Exiting the Quantum Control Software.”

2.	 While holding down the <Shift> key on the keyboard, run the Quantum Control 
Software by following the instructions in “Running and Exiting the Quantum 
Control Software.” When the Quantum Control Software screen opens, release the 
<Shift> key.

See “System Configuration” if you are creating a presentation for a new system or need 
to make changes to the existing configuration.

See “Creating a Presentation” for information about placing sources on the target display.

Loading an Existing Presentation

1.	 Click the  button on the main toolbar.

- or - 
From the File menu, select Open. 
- or -  
Press <Ctrl + O> on the keyboard.

The Open dialog box appears.

2.	 Locate the file to be loaded and click Open.

Saving a Presentation

To save the current presentation, click the  button on the main toolbar. You can also 
select Save from the File menu or press <Ctrl + S> on the keyboard.

If the presentation has not been saved previously (it is untitled), the Save As dialog box 
opens, allowing you to specify a name.

To save a copy of a presentation:

1.	 From the File menu, select Save As. The Save As dialog box opens.

2.	 In the File Name field, enter an appropriate name for the presentation. A .ctp 
extension is automatically appended to the file name.

3.	 Click Save to save the file.

When creating a presentation, save your work regularly. You can also have the Quantum 
Control Software automatically create backup files at regular intervals (see “Using the  
Auto-Backup Function”).
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Using the Auto-Backup Function

The Quantum Control Software can automatically back up your presentation at specific 
intervals. In the event that any changes are lost before saving (such as due to a power 
outage), you may be able to limit the amount of work you lost by restoring the last  
auto-backup file.

Setting the backup timer
1.	 From the Backup menu, select Setup Backup Timer. The Backup Setup dialog box 

opens.

Figure 3.	 Backup Setup Dialog Box

2.	 Ensure that the Disable Backup check box is cleared to enable auto-backup.

NOTE:	 If you do not want to use auto-backup, ensure that the Disable Backup 
check box is selected.

3.	 In the Hours and Minutes fields, enter the desired values to set the desired interval 
between each backup.

4.	 In the Backup Folder field, enter the full path of the Windows folder where the 
backup files are to be saved. By default, these are saved in the Quantum Elite or 
Quantum Connect folder.  
- or -  
In the Backup Folder field, click Browse to navigate to the folder where the files are to 
be saved.

5.	 Click OK.

Restoring an auto-backup file
1.	 From the Backup menu, select Restore. If you made changes to the current file, you 

are prompted to save the file first.

2.	 In the Save prompt, click Yes to save the current file. The Save As dialog box opens if it 
is an untitled file. 
- or -  
Click No to exit the current file without saving.

The Open dialog box is displayed.

NOTE:	 Backup files are contained within folders according to the date they were 
created. The files are named with the presentation title and the time they 
were created.

3.	 Double-click the folder for the desired date to open it.

4.	 Select the backup file that you want to restore and click Open.
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System 
Configuration

This section describes the four procedures or tasks associated with configuring the  
Quantum Control Software to work correctly with a Quantum Elite or Quantum Connect 
videowall processor. Topics that are covered include:

zz Choosing a Display Processor

zz Layout Configuration

zz Communications Setup

zz Setting Up Sources

The tasks described in this section can be completed in any order but the order in which 
they are listed above is recommended. Unless otherwise stated, all configuration settings 
described in this section are saved in the presentation (.ctp) file.

Choosing a Display Processor
Before the Quantum Control Software can control a Quantum Elite or Quantum Connect, it 
must be detected and connected using the Choose Display Processors task.

NOTE:	 Quantum Connect does not support the use of multiple processors.

1.	 Click the Choose Display Processors button in the taskbar. 

The Choose Display Processors workspace opens.

Figure 4.	 Choosing Display Processors
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2.	 Click the  button on the toolbar.  
- or - 
From the Detect menu, select Detect.

The Quantum Control Software polls for any Quantum processors accessible via its 
Ethernet port. An information panel is displayed for each processor detected, as shown 
in figure 4.

3.	 To connect to a Quantum processor, select the Connect check box in the row of the 
appropriate processor. If you are using more than one processor, you need to connect 
to each processor in the same manner.

NOTE:	 If the check box does not stay selected, this indicates that the  
Quantum Control Software is unable to establish or maintain a connection 
(for instance, due to a faulty cable or the Quantum processor and PC not 
being on the same IP subnet).

You can disconnect from a Quantum processor by clearing the Connect check box for 
the appropriate processor.

Assigning a Name to a Quantum Processor

If you are using the Quantum Control Software to control more than one processor, you 
can give a name to each processor that easily identifies its role within the system. This is 
especially useful when assigning processors to the target display screens.

For example, if you are using two processors driving the left and right sides of the target 
display array, you can name the two processors Left and Right, respectively.

To assign a name, enter a suitable name in the Name field for the appropriate processor.

Layout Configuration

Choosing a Display Layout

The target display can be a single screen or several screens interlocked to form a larger 
display area. Therefore, you need to define the layout within the Quantum Control Software.

The selected layout appears as the virtual display in the Scene Design task (see “Creating a 
Presentation”). This allows you to place sources exactly where you want them to appear on 
the actual display array.

Use the Choose Layout task to choose and configure the display layout.
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To choose and configure a layout:

1.	 Click the Choose Layout button on the taskbar. 

The Choose Layout workspace opens.

Figure 5.	 Choose Layout Workspace

2.	 From the display layout diagrams, select the layout that matches the arrangement of 
your target display screens. The currently selected layout is highlighted with a light gray 
background and red outline.

TIP:	 See “Designing a New Layout”or “Modifying an Existing Layout” if the 
default layouts do not match your particular display configuration.

3.	 Right-click a screen (usually starting with the top left screen) in the chosen layout and 
select Change Screen Processor IP from the drop-down list. The following dialog 
box opens:

Figure 6.	 Set Options Dialog Box
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4.	 From the Processor IP drop-down list, select the IP address of the processor you are 
using. The Processor IP drop-down list displays all processors currently connected to  
the Quantum Control Software via the Choose Display Processors task. If no processors 
are listed, connect to one as described in “Choosing a Display Processor.”

5.	 The Available Outputs drop-down list displays currently unassigned output cards (by 
slot number). Select one to assign to this screen.

NOTE:	 There are two output channels on each output card and selecting from the 
Available Outputs list assigns the primary output (channel 1) to the screen. 
The secondary output (channel 2) is assigned automatically using the Second 
Output setting (see figure 7 for examples).

Figure 7.	 Example Display Layouts and Channel Configurations

6.	 In the Second Output section, select how the secondary output should be assigned. 
Choose from:

zz Horizontal — The secondary output is assigned to the screen immediately to the 
right of the primary output (when viewed from the front of the display).

zz Vertical — The secondary output is assigned to the screen immediately below the 
primary output.

zz Do not Assign — The secondary output is not assigned; only the primary output is 
used.
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7.	 Click OK to confirm the assignments.

NOTE:	 Screens that have been assigned or mapped appear with a green 
background in the layout diagram. Unassigned screens have a gray 
background.

8.	 Repeat steps 3 through 7 for remaining screens in the layout.

Designing a New Layout

If the desired target display layout is not one of the options available by default, you can 
create rectangular layouts as follows:

1.	 From the Layouts menu select New. The New Wall Layout dialog box opens.

Figure 8.	 New Wall Layout Dialog Box

2.	 In the Name field, enter a name or brief description for the layout.

3.	 In the Wall layout section, set the overall horizontal and vertical size of the target display 
(measured in whole screens) by clicking the Left and Right Arrows in the Columns 
field and the Up and Down Arrows in the Rows field. Alternatively, you can enter the 
desired values in the Columns and Rows fields.

4.	 From the Output Mode drop-down list, select the desired resolution of each screen.

NOTE:	 This sets the correct screen mapping used to determine grid snaps and 
source window scaling.

5.	 To enable mullion compensation, select the Mullion Adjustment radio button in the 
Mullion/Edge Blending Compensation section. Mullion is the area of frame border that 
exists between two displays. This area must be taken into account so that when an 
image is spread across two or more displays, the image flow is not distorted. 

6.	 If you are using projectors that support soft edge blending, select the Edge Blend 
Compensation radio button and set the amount of overlap required by using the 
controls in the Mullion/Edge Blending Compensation section.

NOTE:	 The Quantum Elite compensates for the edge blend area but does not adjust 
the brightness in the area.
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7.	 Select the Link check box to link the Horizontal and Vertical adjustment values. When 
the check box is selected, the Vertical field is grayed out and equals the Horizontal 
value.  
- or - 
If you clear the Link check box, you can enter separate values for the horizontal and 
vertical adjustment.

8.	 Click OK to save the new layout.

NOTE:	 The Quantum Connect does not support the use of edge blended displays.

Modifying an Existing Layout
1.	 Right-click a screen in the chosen layout and select Edit Wall Layout from the  

drop-down list. The Wall Layout Properties dialog opens.

2.	 Edit the various settings as needed (see “Designing a New Layout”).

3.	 Click OK to save the layout.

Importing a Layout

You can import display layouts from another Quantum Control Software file (with a .ctp file 
extension) as follows:

1.	 From the Layouts menu, select Import. The Import Wall Layout dialog opens.

2.	 Locate the file that contains the desired layout and click Open.

NOTE:	 This imports all layouts from the selected file that are not already in the existing 
file. You can delete any unwanted layouts as described in “Deleting a Layout.”

Deleting a Layout

You can delete any of the display layouts that appear in the Choose Layout workspace.

NOTE:	 You cannot undo this operation.

To delete a layout:

1.	 Click on the layout to be deleted.

2.	 From the Layouts menu, select Delete.
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Arranging Layouts

You can change the way layouts are presented in the Choose Layout workspace. This can 
be helpful if there are a large number of layouts and you want to be able to see them more 
easily.

To arrange layouts:

1.	 From the View menu, select Arrange Layouts. The Arrange Layouts dialog box opens.

Figure 9.	 Arrange Layouts Dialog Box

2.	 In the Columns field, click the Up and Down Arrows or enter a value to set the number 
of icon columns to be displayed.

3.	 In the Panel Size field, click the Up and Down Arrows or enter a value to set the 
relative panel size for the display layout.

4.	 Click OK.

Restoring Default Layouts

You can restore the default layouts that were present when you first installed the Quantum 
Control Software. Performing this operation deletes any user-defined layouts.

To restore a default layout:

From the Layouts menu, select Default.

Communications Setup
Ensure that the serial ports of the computer are correctly configured if:

zz You are using the Quantum Control Software to control external devices such as source 
switchers.

- or -

zz You wish to remotely control the Quantum System using serial data strings.
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To open the Communications Setup workspace:

Click the Communications Setup button on the taskbar. 

The Communications Setup workspace opens.

Figure 10.	Communications Setup Workspace

The left side of the Communications Setup workspace contains a Devices tree, similar to 
Windows Explorer. There are two main folders:

zz Serial Devices — Lists any serial device drivers that are currently loaded. Alternatively, if 
no device drivers are found, any available serial (COM) ports detected by the Quantum 
Control Software are listed.

zz Settings — Allows XML device drivers to be enabled or disabled for serial or Ethernet 
control (see “XML Device Drivers”)

The details displayed in the main area of the workspace change according to the type of 
item selected in the device tree.

Serial Ports

Any unused serial ports (serial ports not used by a device driver) are listed in the Serial 
Devices folder. These can be configured manually as follows:

1.	 Select the appropriate port number (such as COM1 or COM3) in the Serial Devices 
folder of the Devices tree. The Port Settings and Serial Commands sections appear in the 
workspace.

2.	 In the Port Settings section, adjust the various parameters as required.

3.	 In the Serial Commands section, choose whether the port is to be used for incoming 
(input) or outgoing (output) data, by selecting the appropriate check box.

NOTE:	 Only one port can be used for input data and only one for output data. The 
Current Ports section shows which ports are currently in use. You can use 
the same port for both input and output data. 
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XML Device Drivers

Device drivers are defined by an XML file, located in the following folder on the hard disk of 
the computer:

C:\Program Files\Extron\Quantum Elite\XML\Device Drivers for the Quantum 
Elite Control Software.

- or - 

C:\Program Files\Extron\Quantum Connect\XML\Device Drivers for the Quantum 
Connect Control Software.

Contact the Extron S3 Sales & Technical Support Hotline for further advice on creating an 
XML device driver file.

To enable XML device drivers:

1.	 In the Settings folder of the Devices tree, click XML Driver Path. An Enable XML 
Device Drivers check box appears on the right side of the workspace. 

2.	 Select the Enable XML Device Drivers check box to load the device drivers. A dialog 
box opens while the Quantum Control Software loads the drivers. Then, the driver 
names appear in the Ethernet Devices and Serial Devices folders of the Devices tree.

Setting Up Sources
Each source that you need to use in a presentation must have a corresponding source 
definition within the Quantum Control Software.

A source definition contains full details of the source, such as its signal format (NTSC, PAL, 
RGB, DVI, and so on) and to which input channel on the Quantum processor the source is 
connected.

If you are using an external source switcher (such as to give access to multiple sources on 
one input), the source definition can also include a serial command string used to operate 
the switcher. A separate source definition is required for each of the sources that can be 
connected to the Quantum processor.

NOTE:	 You need to set up communications with a switcher before you can define any 
sources selected via the switcher (see “Communications Setup”).

When the Quantum Control Software needs to display a particular source, it uses the 
parameters in the source definition to configure the appropriate input channel for the 
source. 

Source definitions are created and set up using the Set Up Sources task.

NOTE:	 The Quantum Connect Control Software does not support the use of GQE 100, 
Clock, and picture source types.
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To view the Set Up Sources Task:

Click the Set Up Sources button on the taskbar. 

The Set Up Sources workspace opens.

Figure 11.	Set Up Sources Workspace

The source explorer, on the left side of the Set Up Sources workspace, shows a list of source 
types supported by the Quantum processor. Source definitions are listed under the relevant 
source type.

The information is displayed as a tree that expands up to three levels as shown in figure 11.

When you open the source explorer after creating an entirely new presentation (or for the 
first time after installation), there are no source definitions listed.

Creating Quantum Source Types and Source Definitions
1.	 Within the source explorer of the Set Up Sources workspace, right-click Display 

Processors and select the desired option. Available options include:

zz Create Quantum Sources — This operation adds a list of the supported source 
types to the source tree. Then, you need to create source definitions.

zz Detect Sources — Selecting this option is the easiest method to create source 
types. For correct operation, you need to have a Quantum processor connected 
to the PC with the installed Quantum Control Software. The Quantum Control 
Software communicates with the Quantum processor and automatically detects 
the number and type of input cards that are present. The source type list is built 
automatically. If sources are connected to the processor, the source definitions are 
created automatically.

zz Update Sources — Selecting this option when connected to a Quantum processor 
updates the source tree details.
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2.	 Right-click the appropriate source type heading in the source explorer (such as RGB,  
QGE 100, Video, and so on) and select Create New Source from the drop-down 
menu. An empty source definition screen opens in the workspace (see figure 11 for an 
example of a new video definition).

3.	 In the Source Name field, enter a name for the source.

4.	 If a serial string is required for the source (for instance, to operate an external switcher), 
enter the appropriate control string in the Source Selected TX field.

5.	 In the Parameters section, enter the required settings for the source. These settings vary 
according to the source type and are detailed in “Source Parameters.”

The following dialog opens if you click Detect Sources within a source definition.

Figure 12.	Quantum Source Selection Dialog Box

Select a source from the list and click OK to create a source definition for it.

Deleting Source Definitions

To delete a single source definition:

1.	 Right-click the appropriate source definition in the source explorer and select Delete 
Source from the drop-down menu.

2.	 In the Delete Source dialog box, click Yes to confirm the deletion.

To delete all source definitions:

Right-click Display Processors in the source explorer and select Remove All 
Devices from the drop-down menu.
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Source Parameters

The following describes source parameters for each Quantum source type, along with a 
description of functionality and available options. These parameters are displayed in the Set 
Up Sources workspace when you select a source definition in the source explorer  
(see figure 11).

Source parameters — Video

Use the Video source type to view a video source connected to a Quantum Video Input 
Card.

Figure 13.	Video Source Parameters

Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 command 
to a matrix switcher.  

ID zz <Enter source input number>

zz <Automatically detect source 
input number>

Displays the source input number on the 
Quantum identified by the card slot number 
and card input number.
To detect this value, use the Detect Sources 
button (see “Creating Quantum Source 
Types and Source Definitions”).
For example, 5.3 is the source connected to 
input 3 of the card in slot 5.

Location zz <Enter IP address>

zz <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the source is connected.
To detect the IP address, use the Detect 
Sources button (see “Creating Quantum 
Source Types and Source Definitions”).

Quantum Control Software • System Configuration 24



Parameter Parameter Value Description

Format zz <Read-only field>

zz <Select an option from the  
drop-down list of format types>

This parameter depends on the AutoDetect 
setting.

zz If AutoDetect is set to True, this parameter 
is read-only, showing the current source 
format as detected by the Quantum 
processor.

zz If AutoDetect is set to False, you can select 
an available source format.

AutoDetect zz True: 
Allows Quantum processor to 
automatically detect current source 
type

zz False: 
Allows you to manually select the 
source type from the Format  
drop-down list.

Sets whether the Quantum processor is to 
automatically detect the current source type

Deinterlace zz 1i: 
Single Field Interpolation

zz 3i: 
Three Field Interpolation

Sets the deinterlace mode to be applied to the 
source.
See the Quantum User Guide for further 
information about deinterlacing.

Input zz Auto: 
Automatically discovers the format

zz SVideo: 
Forces S-video mode

zz Composite: 
Forces composite mode

Sets the input format

Always On zz False (default): 
Source is not always on

zz True: 
Source is always on

Sets whether the source is always on
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Source parameters — RGB

Use the RGB source type to view an RGB graphics or HD video source connected to a  
Quantum RGB Input Card.

Figure 14.	RGB Source Parameters

Parameter 
Group

Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Switch 
Setting

Source Selected 
TX

<Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 
command to a matrix switcher.

Source 
Properties

Source ID zz <Enter source input number>

zz <Automatically detect source 
input number>

Displays the slot and channel 
number of the RGB card in the 
Quantum frame.
To detect this value, use the Detect 
Sources button (see “Creating 
Quantum Source Types and 
Source Definitions”).
For example, 5.3 is the source 
connected to input 3 of the card in 
slot 5.

Source Location zz <Enter IP address>

zz <Automatically detect IP 
address>

Displays the IP address of the 
Quantum card frame where the 
source is connected.
To detect the IP address, use the 
Detect Sources button (see 
“Creating Quantum Source Types 
and Source Definitions”).
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Parameter 
Group

Parameter Parameter Value Description

Source 
Format

Format zz <Read-only field>

zz <Select an option from the 
drop-down list of format types>

This parameter depends on the 
AutoDetect setting.

zz If AutoDetect is selected, this 
parameter is read-only, showing 
the current source type as 
detected by the Quantum 
processor.

zz If AutoDetect is not selected 
(radio button is cleared), you can 
select an available source format.

Colour Space zz RGB (default):
Default mode

zz Component HD:
Option for component HD inputs

zz Component SD:
Option for component SD inputs

Select the required color space.

Auto Detect zz True (select Auto Detect radio 
button):

Allows Quantum processor to 
automatically detect the current 
source type

zz False (select Manual radio button): 
Allows you to manually select the 
source type from the Format  
drop-down list. 

Sets whether the Quantum 
processor is to automatically detect 
the current source format.

Manual zz True (select Manual radio button):
Allows you to manually select the 
source type from the Format  
drop-down list. 

zz False (select Auto Detect radio 
button):

Allows Quantum processor to 
automatically detect the current 
source type

When this mode is enabled, the 
input mode can be forced to a 
known format.
In addition, new custom input 
modes can be built (see “Creating a 
custom input mode”).

Adjustments Brightness, 
Contrast

<Enter values for brightness and 
contrast>

Adjusts the brightness and contrast 
of a source

Phase, Pixel 
Clock

<Enter values for phase and pixel 
clock>

Adjusts the sample clock parameters. 
Ensure that the Auto Phase check 
box is not selected.

Auto Phase zz <Select Auto Phase check box>:
Enables Auto Phase and adjusts clock 
phase automatically

zz <Clear Auto Phase check box>:
Disables Auto Phase

Sets whether to automatically adjust 
clock phase
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Parameter 
Group

Parameter Parameter Value Description

Source 
Viewporting

X Pixels, Y Pixels,  
H pos, V pos

<Enter values for size (X pixels 
and Y pixels) and position (H pos 
and V pos)>

These controls allow a section of the 
captured source to be isolated as a 
viewport.
There is only one viewport for each 
input channel.

Image Auto 
Centre

zz Off: 
No automatic centering

zz Once: 
Centers source image as part of the 
Detect process

zz Continuous: 
Continually monitors and centers 
input source

Sets whether to automatically center 
the input source image and at what 
frequency.

Keep Scene zz <Select Keep Scene check box>: 
Displays the current scene, not the 
source

zz <Clear Keep Scene check box>: 
Displays source on Quantum output 
1.1

Sets whether to displays the current 
scene or the source
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Creating a custom input mode

You can create custom input formats for RGB sources in the Set Up Sources workspace. 

To do so:

1.	 Within the source explorer of the Set Up Sources workspace, select an RGB source (or 
create a new RGB source type and definition as described in “Creating Quantum 
Source Types and Source Definitions”). The definition screen for the selected source 
opens in the workspace (see figure 11 for an example). 

2.	 In the Source Format section, select the Manual radio button (see figure 14). This 
disables Auto Detect mode and lets you choose a known source format.

3.	 From the Format drop-down list, select the format to use as a starting point.

4.	 Click New. The User Custom Input Mode dialog box opens. 

 

Figure 15.	 User Custom Input Mode Dialog Box

5.	 In the Mode Name field, enter a name for the custom mode.

6.	 From the Template Format drop-down list, verify that the desired template is selected 
for the customized format.

7.	 From the Colour Space drop-down list, select the color space to use (such as RGB, 
Component SD, or Component HD).

8.	 In the Active Area section, adjust the settings as needed by manually entering values 
into the appropriate fields. Alternatively, click the Up and Down Arrows to adjust the 
values. You can adjust the following settings:

zz Active Lines

zz Active Pixels

zz Total Pixels

zz First Active Line

zz First Active Pixel
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9.	 In the Signature Parameters section, adjust the settings if needed. 

CAUTION:	 Adjust the parameters in the Signature Parameters section, only if 
absolutely necessary to produce the required image. Changes to these 
settings may affect the reliablility of the Auto Detect feature.

You can adjust the following settings:

zz Total Lines

zz Line Period

zz VSync Lines

zz Sync Polarity

zz Interlaced

10.	Click Apply to save the changes and continue making other modifications. Alternatively, 
click OK to save the changes and close the User Custom Input Mode dialog box.

Editing an input mode

You can adjust the settings of custom input modes as well as existing factory formats. 

CAUTION:	 When adjusting input modes provided with this application, you are making 
changes to the original factory formats. Any changes made cannot be 
undone.

To do so:

1.	 Within the source explorer of the Set Up Sources workspace, select an RGB source (or 
create a new RGB source type and definition as described in “Creating Quantum 
Source Types and Source Definitions”). The definition screen for the selected source 
opens in the workspace.

2.	 In the Source Format section, ensure the Manual radio button is selected.

3.	 From the Format drop-down list, select the format to be modified.

4.	 Click Edit. The User Custom Input Mode dialog box opens.

5.	 Adjust the settings as necessary.

6.	 Click Apply to save the changes and continue making other modifications. Alternatively, 
click OK to save the changes and close the User Custom Input Mode dialog box.

Deleting a custom input mode

To delete a custom format:

1.	 Within the source explorer of the Set Up Sources workspace, select an RGB source (or 
create a new RGB source type and definition as described in “Creating Quantum 
Source Types and Source Definitions”). The definition screen for the selected source 
opens in the workspace.

2.	 In the Source Format section, ensure the Manual radio button is selected.

3.	 From the Format drop-down list, select the format to be deleted.

4.	 Click Delete. The format is removed from the Format drop-down list and the No 
Format Set option is selected.
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Source parameters — DVI

Use the DVI source type to view a source connected to a Quantum DVI Video Input Card.

Figure 16.	DVI Source Parameters

Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 command 
to a matrix switcher.

ID zz <Enter source input number>

zz <Automatically detect source 
input number>

Displays the source input number on the 
Quantum identified by the card slot number 
and card input number.
To detect this value, use the Detect Sources 
button (see “Creating Quantum Source 
Types and Source Definitions”). 
For example, 5.2 is the source connected to 
input 2 of the card in slot 5.

Location zz <Enter IP address>

zz <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the source is connected.
To detect the IP address, use the Detect 
Sources button (see “Creating Quantum 
Source Types and Source Definitions”).

Format <Read-only field> Reports the source type as detected by the 
Quantum processor

Colour Space zz RGB (default):
Default mode

zz Component SD:
Option for component SD inputs

zz Component HD:
Option for component HD inputs

Select the required color space.
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Source parameters — QGE 100

Use the QGE 100 source type to display a source derived from a QGE 100.

NOTE:	 The Quantum Connect does not support the use of QGE 100 sources.

Figure 17.	QGE 100 Source Parameters

Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 command 
to a matrix switcher.

Server <Enter name or IP address of host 
or source computer>

Specifies the network name* or IP address of 
the QGE 100 source
*To use names, the network must support DNS 
(Dynamic Name Services).
For example, to select a QGE 100 source 
called “QGE100” with an IP address of 
178.28.229.101, enter either QGE1ØØ or 
172.28.229.1Ø1.

IPAddress <Enter IP address> Displays the IP address of the QGE 100 where 
the source is connected.  
This field must be left blank if the adapter is 
using DHCP.

Multicast Address <Enter multicast address of the 
connected QGE 100>

If the source is a QGE 100 operating in 
Multicast mode, enter its multicast address 
here.
For example, enter 234.5.6.183.

Multicast Port <Enter multicast port number of 
the connected QGE 100>

The default port is 5000.

Quantum Control Software • System Configuration 32



Source parameters — Picture

Use the Picture source type to display an image file (in JPG, GIF, PNG, or BMP format). The 
file can be located on the Quantum processor hard drive (in the d:/pictures folder) or 
elsewhere on the network.

NOTE:	 The Quantum Connect does not support the use of Picture sources.

Figure 18.	Picture Source Parameters

Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 command 
to a matrix switcher.

Filename <Enter path and filename of the 
desired image>

Indicates the path and filename of the desired 
image.
For example:

zz To select a file on the Quantum processor, 
use the format: 
d:/pictures/companylogo.jpg

zz To select a file on a network computer or 
server, use the format: 
\\imageserver\companylogo.jpg

Location zz <Enter IP address>

zz <Automatically detect IP 
address>

Displays the IP address of the Quantum card 
frame where the image file is located.
To detect the IP address, use the Detect 
Sources button (see “Creating Quantum 
Source Types and Source Definitions”).
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Parameter Parameter Value Description

GraphicsOverlay zz True:
Makes the specified key color in the 
image transparent

zz False:
Disables transparency (key color is 
opaque)

Sets whether to make the specified key color 
transparent

KeyColour <Enter three values from 0 to 255> zz If GraphicsOverlay parameter is set to True: 
These values set the color in the image that 
will be transparent

zz If Graphics Overlay parameter is set to 
False: These values set the red, geen, and 
blue levels. 
For example:

zz 255,255,255 = White
zz 0,0,0 = Black
zz 0, 0, 255 = Blue

Source parameters — Timer

Use the Timer source type to create an on-screen clock or count-down or count-up timer.

NOTE:	 The Quantum Connect does not support the use of Clock or Timer sources.

Figure 19.	Timer Source Parameters
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Parameter Parameter Value Description

Source Name <Enter name for source> Descriptor to identify the source

Source Type <Read-only field> Displays the type of source

Source Selected TX <Enter RS-232 string to be 
transmitted to a connected matrix 
switcher>

This is optional. Transmits an RS-232 command 
to a matrix switcher.

ID <Enter an alphanumeric label> User-defined alphanumeric label (such as the 
source name) that is unique to the show

GraphicsOverlay zz True:
Makes the specified background color 
in the image transparent

zz False:
Disables transparency (background 
color is opaque)

Sets whether to make the background color of 
the image transparent

Size zz Small

zz Medium (default)

zz Large

zz Extra Large

Sets the size of text on the clock or timer 
display

ForeColour <Enter three values from 0 to 255> Sets the foreground (text) color for the clock or 
timer display. These values set the red, green, 
and blue levels.
For example:

zz 255,255,255 = White (default)

zz 128,0,0 = Mid-red

zz 255,255,0 = Bright yellow

BackColour <Enter three values from 0 to 255> Sets the background color for the clock or 
timer display. These values set the red, green, 
and blue levels. 
For example:

zz 0,0,0 = Black (default)

zz 128,0,0 = Mid-red

zz 0,0,75 = Dark blue

Font zz Arial

zz Verdana (default)

zz Microsoft Sans Serif

zz Tahoma

Sets the font for the clock or timer display

TimeFormat zz 12:
Sets 12-hour time format

zz 24 (default):
Sets 24-hour time format

Sets the time format for the clock or timer 
display

ShowSeconds zz True:
Displays hours, minutes, and seconds

zz False:
Displays only hours and minutes

Sets whether to display seconds in the time
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Parameter Parameter Value Description

ShowDate zz True:
Displays the date and time

zz False:
Displays only the time

Sets whether to display the date along with 
the time

DateFormat zz dd/mm/yyyy (default)

zz mm/dd/yyy

zz 20 June 2006

zz June 20 2006

Sets the format to use when displaying the 
date

ShowWeekDay zz True:
Displays the day of the week (Monday 
to Sunday) and the date

zz False:
Displays only the date

Sets whether to display the day of the week 
along with the date

TimerStartTime <Enter the time from which the 
timer begins>

When operating in Timer mode, this value 
defines the start time in hh:mm:ss. The default 
is 00:00:00.
In countdown mode, when the timer reaches 
zero, the timer reloads with the preset value 
and starts again.

ClockMode zz Clock (default)

zz Timer

Sets whether the display shows a standard 
clock or a timer. 
For Timer mode, set the TimerCountDirection 
parameter as needed.

TimeZone <Select an option from the 
drop-down list of time zones>

Sets the time zone to use for the clock and 
date

Alignment zz Left

zz Center (default)

zz Right

Sets the horizontal alignment of the display, 
relative to the window in which it is placed. 

TimerCountDirection zz Up (default)

zz Down

When using Timer mode, use this parameter to 
set the direction in which the timer will count. 
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Creating a 
Presentation

This section describes the Scene Design task and creating a presentation using scenes and 
windows. Topics that are covered include:

zz Working with Scenes

zz Working with Windows

Working with Scenes
To view a source on the target display, place a window (containing the appropriate source) 
on the display. Windows and scenes are created and edited in the Scene Design task.

You can store the size, position, and contents of one or more windows as a scene. Each 
scene can have a different arrangement of windows and sources.

NOTE:	 The number of windows allowed within a scene depends on the Quantum 
processor hardware. The maximum is 128 windows per output card. See the 
Quantum User Guide for more details.

To open the Scene Design task: 

Click the Scene Design button on the taskbar.        

The Scene Design Workspace opens.

Figure 20.	Main Features and Toolbars of the Scene Design Task

Quantum Control Software • Creating a Presentation 37



Creating a New Scene

New scenes are added to the end of the scene list. A new scene has the same window 
palette (see “Working with Windows”) as the currently selected scene. No other attributes 
are copied from the selected scene.

To create a new scene:

1.	 Click the  button on the Scene Properties toolbar. The Scene Properties dialog 
opens.

Figure 21.	 Scene Properties Dialog Box

2.	 Modify the default scene title as desired. To change other settings follow the procedure 
described in “Changing Scene Properties.” 

3.	 Click OK. In the Scene Control workspace, a new Scene Selection button is also 
added for the new scene (see “Using the Scene Control”). 

4.	 Add a window to the scene (see “Adding a Window to a Scene and Choosing a 
Window Source”).

Copying an Existing Scene

You can create an exact copy of any scene that exists in your presentation. This is useful 
when creating a number of scenes that only have slight variations from each other.

The copied scene is inserted immediately after the original scene. It has the same window 
palette, window layout, control commands, and Auto Play settings as the original scene.

To copy an existing scene:

1.	 In the scene list of the Scene Design workspace, select the name of the scene to be 
copied.

2.	 Click the  button on the Scene Properties toolbar. The Scene Properties dialog box 
opens for the copied scene (see figure 21).

3.	 Modify the default scene title and other settings as needed.

4.	 Click OK. In the Scene Control workspace, a new Scene Selection button is also 
added for the copied scene (see “Using the Scene Control”).
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Deleting a Scene
1.	 In the scene list of the Scene Design workspace, select the scene to be deleted. The 

selected scene is displayed in the workspace.

2.	 Click the  button on the Scene Properties toolbar. In the Scene Control, the 
corresponding Scene Selection button is also deleted (see “Using the Scene 
Control”).

Changing Scene Properties

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar.  
- or - 
For any scene, right-click the scene title in the scene list.

The Scene Properties dialog box (see figure 21) opens.

2.	 Modify the settings as needed. 
These settings include:

zz AutoPlay Delay (mSec) — Set the amount of time that the scene is displayed 
during Auto Play (see “Changing the Display Time for a Scene”).

zz Include Scene in Autoplay — Select this check box to include this scene in an 
AutoPlay presentation. Clear this check box to exclude the scene (see “Changing 
the Display Time for a Scene”).

zz Don’t display windows - send serial strings only — By selecting the Don’t 
display windows check box on the Scene Properties dialog, only the serial strings 
(if any) associated with the string are executed. Any source or layout changes in 
the scene are ignored. This allows the scene to transmit a serial command without 
changing the current layout of the target display, such as to operate an external 
source switcher.

3.	 Click OK.

NOTE:	 Any changes that are made to the scene title do not automatically update the 
button text that is located in the Scene Control workspace (see “Changing the 
properties of a button”).
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Scene Commands

Adding a scene command

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar.  
- or - 
For any scene, right-click the scene title in the scene list.

The Scene Properties dialog box (see figure 21) opens.

2.	 Select the appropriate Scene Commands tab. The available tabs include:

zz Pre Scene Commands — Commands that occur as soon as the scene is selected 
but not yet fully displayed

zz Post Scene Commands — Commands that occur when the scene display is fully 
complete

zz Exit Scene Commands — Commands that occur when another scene is selected 
but before the pre-scene commands of the new scene

NOTE:	 The procedure to add, edit, or remove commands from each tab is the 
same.

3.	 Click Add to display the Add Command dialog box.

Figure 22.	 Add Command Dialog Box

4.	 From the Device drop-down list, select the device for which you want to add a 
command.

5.	 In the Commands section, select the desired command name from the list. If you select 
a non-XML defined serial port (which is listed as output), a text box is displayed for you 
to enter a free format text string.

6.	 Click OK to add the command to the scene.
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Changing the order of scene commands

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar.  
- or - 
For any scene, right-click the scene title in the scene list. 

The Scene Properties dialog (see figure 21) opens.

2.	 Select the appropriate Scene Commands tab.

3.	 In the command list, select the command to be moved.

4.	 In the Command Ordering section, click the Move Up or Move Down button to move the 
command to the desired position in the list.

Removing a scene command

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar. 
- or - 
For any scene, right-click the scene title in the scene list. 

The Scene Properties dialog (see figure 21) opens.

2.	 Select the appropriate Scene Commands tab.

3.	 In the command list, select the command to be removed.

4.	 Click Remove.

Editing a serial (output) scene command

1.	 Select a scene in the scene list of the Scene Design workspace and click the  
button on the Scene Properties toolbar.  
- or - 
For any scene, right-click the scene title in the scene list. 

The Scene Properties dialog (see figure 21) opens.

2.	 Select the appropriate Scene Commands tab.

3.	 In the command list, select the output name.

4.	 Click Edit.

5.	 Edit the free format text string as needed.

6.	 Click OK.

Changing the Order of Scenes and Scene Navigation

You can change the order of the scenes in the scene list. When using the Auto Play option, 
scenes are recalled in the order that they appear in this list.

To move a scene in the scene list:

Drag and drop the scene title to a new position in the scene list.
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You can use the Scene Control toolbar, scene list, and keyboard to navigate to the scene you 
want to view or edit.

To go to... Click...

a specific scene the scene title in the scene list.

the next scene
the  button or press the <Down Arrow> key on the 
keyboard.

the previous scene
the  button or press the <Up Arrow> key on the 
keyboard.

the first scene
the  button or press the <Home> key on the keyboard.

the last scene
the  button or press the <End> key on the keyboard.

Working with Windows
In the Scene Design workspace, the actual target display is represented by the virtual display 
area and each window that can be placed on the display is represented by a virtual window. 

Each virtual window has a unique number (automatically assigned by the Quantum Control 
Software) and a user-definable label that is typically used to identify the source.

Figure 23.	Virtual Window with Label

When you create a new presentation, nine virtual windows are docked in the window 
palette (see figure 20).

NOTE:	 You can add more windows if required (see “Adding More Windows to the 
Palette”), but after they are added, they cannot be deleted.

The contents of each window can be the same or different between scenes. Initially, each 
window has a dark gray background indicating no source is selected for the window. As you 
create new scenes, the contents of each window in the palette are copied from the windows 
of the currently selected scene.
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To use a window within a scene, click and drag the window from the window palette into 
the virtual display area. The appearance of the window in the window palette changes 
depending on whether it is docked (not used in the scene) or undocked (used in the scene).

Figure 24.	Docked and Undocked Windows in the Window Palette

Adding More Windows to the Palette

NOTE:	 Windows cannot be deleted from the window palette.

When you hover over a window in the pallete, a popup opens showing the window number 
and its source type. For example:

Figure 25.	Window Details Popup

To add a window to the palette:

Right-click anywhere in the window palette and select Add Window from the  
drop-down menu. A new window is added to the window palette with a default color 
wash and is given the next available window number.

You can also right-click in the virtual display or workspace (but not in an existing 
window) and select Add Window from the drop-down menu. A new window is added to 
the window palette and appears in the workspace area.
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Adding a Window to a Scene and Choosing the Window Source

To add a window to a scene:

1.	 Select a docked window in the window palette to be added to the current scene. It is 
indicated with a red outline.

2.	 Click the  button on the Window Properties toolbar.  
- or -  
Drag the window into the virtual display area. 
- or -  
Press the <Delete> key on your keyboard.

3.	 Modify the window as desired (see “Choosing the Window Style”).

To choose a window source:

1.	 Select a window in the window palette or a window in the virtual display area of the 
currently selected scene.

2.	 Right-click the selected window and select Window Source from the drop-down menu. 
The Quantum Sources dialog opens.

Figure 26.	 Quantum Sources Dialog Box

3.	 In the Sources section of the Quantum Sources dialog, select the desired source. You can 
filter the listed sources by selecting an option from the View By or Category  
drop-down lists. You can also search for sources using the Search field.

NOTE:	 The Search field is case-sensitive.

See “Setting Up Sources” for information about changing source parameters.

4.	 Click OK.

Quantum Control Software • Creating a Presentation 44



Removing a Window from a Scene
1.	 In the window palette or in the virtual display area, select the undocked window to be 

removed from the currently selected scene.

2.	 Click the  button on the Window Properties toolbar.  
- or -  
Drag the window into the window palette. 
- or -  
Press the <Delete> key on your keyboard.

Moving and Resizing a Window

To move or resize a window using the virtual display area:

1.	 Select a window in the virtual display area or select an undocked window in the 
window palette of the currently selected scene. In the virtual display area, the window is 
highlighted as shown below: 

Figure 27.	 Selecting a Window

2.	 Move and resize the window as needed.

To resize the window, position the mouse point over one of the resizing handles and 
drag the window border to the desired position. The mouse pointer changes to a double 
arrow symbol, showing which direction the border can be moved.

To move the window, position the mouse pointer within the window and drag the 
window to a new location. The mouse pointer changes to a crossed arrow symbol.

To size the window to fit the entire display array, right-click the window and select Full 
Screen from the drop-down menu.

With the layout grid turned on, window borders automatically align or snap to the grid lines. 
You can temporarily disable this feature by holding down the <Shift> key on your keyboard 
while moving or resizing the window.

If necessary, you can hide the layout grid or change its spacing (see “Changing the Virtual 
Display Properties”).
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Using the Window Size & Position dialog

If you need to position or resize a window with pixel accuracy, you can use the  
Window Size & Position dialog.

1.	 Right-click a window in the virtual display area of the currently selected scene and select 
Adjust Position and Size from the drop-down menu. The Window Size & Position 
dialog opens.

Figure 28.	 Window Size & Position Dialog Box

2.	 Set the Variable aspect ratio check box as needed.

zz Cleared — The vertical and horizontal sizes are locked together. The viewport 
maintains the aspect ratio of the original source.

zz Selected — The vertical and horizontal size can be adjusted independently.

3.	 Click the Position Arrows to adjust the window position or enter pixel values in the X 
(left edge) and Y (top edge) fields.

4.	 Click the Width and Height Arrows to adjust the overall window size or enter pixel 
values in the W (width) and H (height) fields.

5.	 To set the actual source element to a specific size (rather than the overall window size), 
click the Size Arrows to make the necessary adjustments. 
Width and height values in the Source Window Size section show the size of the source, 
allowing for the width of any border or title text (see figure 29).

Figure 29.	 Example of Window Sizing

6.	 Click Apply to update the display with the new settings and leave the dialog box open. 
Click OK to save the new settings and close the dialog or click Cancel to keep the 
existing settings.
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Choosing the Window Style

NOTE:	 The Quantum Connect Control Software does not support the use of window 
styles.

Each window can be given a text label to identify the source on the target display and can 
be given a colored border if desired.

Two types of text labels can be applied to a window:

zz Overlay text — Text is placed over the source.

zz Title text — Text is placed above or below the source on a colored background.

The appearance of window text and borders is defined by a style. A style determines the 
font, size, color and position of text, as well as border width and color.

Figure 30 shows examples of different window styles.

Window styles are defined in an XML file called ESQuantumConfig.xml. To change or add 
to the default styles provided in this version of the Quantum Control Software, you need to 
edit the parameters of this file.

By default, if a style that adds a border or title text is applied to a window, the overall 
window size does not increase. The window source is scaled down to allow the border or 
title text to fit within the same overall window size.

If you need the source to remain a specific size, you need to manually set it to the required 
size using the Window Position dialog. See “Moving and Resizing a Window” for more 
information.
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Figure 30.	Examples of Different Window Styles
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Changing the window style and window text

To change the window style:

1.	 In the window palette or in the virtual display area of the currently selected scene, select 
a window.

2.	 Right-click the window and select Window Properties from the drop-down menu. 
- or -  
From the Window menu, select Window Properties.

The Set Window Properties dialog opens.

3.	 Select the Window Styles tab and choose a style from the Styles list:

Figure 31.	 Window Styles Tab

The Title Text Preview and Overlay Text Preview sections of this tab show the appearance 
of text for the selected style.

NOTE:	 The style called “None” is a plain source window with no border or title text. 
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To change the window text:

1.	 In the window palette or in the virtual display area of the currently selected scene, select 
a window.

2.	 Right-click the window and select Window Properties from the drop-down menu. 
- or -  
From the Window menu, select Window Properties.

The Set Window Properties dialog opens.

3.	 Select the Window Text tab and enter the desired text in the Title Text and Overlay 
Text fields.

Figure 32.	 Window Text Tab

NOTE:	 If the Title Text field is empty, the source name is displayed as title text. If 
the Overlay Text field is empty, no overlay text is displayed.

Changing Zoom Properties

By default, a window that contains a source displays the entire source frame. The source 
is automatically scaled to fit within the window. However, if needed, you can zoom into 
any part of the source frame, such as to exclude unwanted or irrelevant material from the 
source.

The portion of the image that you can zoom into is called a viewport (see figure 33a). A 
viewport can:

zz Be as small as 6 percent of the active source frame.

zz Have the same aspect ratio as the source or be stretched in either the horizontal or 
vertical direction.

zz Be positioned (or panned) to view any part of the source frame.

Regardless of the size, shape, or position of the viewport, the portion of the source image 
that it contains fills the entire window (see figure 33b).
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The number of viewported windows that can be present within one scene is dependent on 
source types as well as the size and shape of the windows.

NOTE:	 Zooming in on part of a source only enlarges the image detail that is already 
present in the source signal. If the image detail is not of good quality, zooming 
in does not increase the level of detail.

Original Source

Original Source

Viewported Source

Viewported Source

An example of using a stretched viewport. Note that if the window does not have the same aspect ratio as the 
original source, the viewported image is compressed or stretched to fit the window. To retain the aspect ratio of 
the viewport, the window needs to be the same shape as the viewport.

b.    

 An example of a standard viewport that preserves the aspect ratio of the original source:a.    

Figure 33.	Example of Source Viewporting
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To change the viewport:

1.	 Right-click the window in the virtual display area and select Zoom Properties from the 
drop-down menu. The Source Properties dialog opens. 

 

Figure 34.	 Source Properties Dialog Box

2.	 Set the Variable aspect ratio check box as needed.

zz Cleared — The vertical and horizontal zoom percentages are locked together. The 
viewport maintains the aspect ratio of the original source.

zz Selected — The vertical and horizontal zoom percentages can be adjusted 
independently.

3.	 Select fine or coarse adjustment by clicking the appropriate radio button (Fine or 
Coarse).

4.	 Click the Zoom/Stretch Arrows to change the size of the viewport.  
- or -  
Click and drag the handles of the viewport area to adjust the size.

To quickly return the Zoom and Stretch settings back to 100 percent (no viewport), click 
Reset.

5.	 Click the Pan Arrows to change the position of the viewport. 
- or -  
Click and drag the viewport area to the desired position.

The target display updates in real time as you make changes to the zoom and pan 
settings.

6.	 Click OK to accept the new viewport settings or click Cancel to retain the previous 
settings.

Changing the Layer of a Window

The layer of a window determines whether it appears in front of or behind other windows. 
Only one window can exist on a layer. A layer is also known as a Z order or priority.

Layers are identified by a number and the higher the number, the further forward the 
window. For example, a window on layer 3 appears in front of a window on layer 2, but 
behind a window on layer 4.

To see the current layer number of a window, hover over the window in the window palette. 
A popup opens showing the window number, its current layer, and source type.

NOTE:	 The maximum number of windows allowed within a scene is dependant on 
the Quantum processor hardware. The maximum is 128 windows per output 
card. See the Quantum User Guide for more information.
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To change the layer:

1.	 Select a window in the window palette or in the virtual display area of the currently 
selected scene.

2.	 Using the Window Properties toolbar, click one of the following buttons to change the 
layer of the window. You can also use the Window menu to change the layer.

Buttons and Menu Options Window Movement

- or -  
From the Window menu, select 
Send Back

Send backward by one layer

- or - 
From the Window menu, select 
Bring Forward

Bring forward by one layer

- or -  
From the Window menu, select 
Send to Back

Send to the back of all layers 
(such as layer 1)

- or -  
From the Window menu, select 
Bring to Front

Bring to the front of all layers

Changing the Virtual Display Properties

Various properties of the virtual display area can be altered based on personal preference or 
to assist in creating scenes in the Scene Design workspace. Most of these properties can be 
changed using the Virtual Display Properties toolbar (see figure 20).

Layout grid

The layout grid in the Scene Design workspace assists you in accurately placing windows on 
the target display. When the grid is visible, the borders of all windows automatically snap to 
the grid. When the grid is not visible, the snap to grid feature is disabled.

To show the grid:

Click the  button. 
- or - 
From the Grid menu, select Enable Snap Grid. This option is listed when no grid is 
visible.
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To hide the grid:

Click the  button. 
- or - 
From the Grid menu, select Disable Snap Grid. This option is listed when the grid is 
visible.

NOTE:	 When the grid is hidden, the snap to grid feature is disabled.

To temporarily disable the snap to grid feature:

Hold down the <Shift> key on your keyboard while placing or resizing the window. 

You can change the number of vertical and horizontal lines in the layout grid.

To increase the number of grid lines:

Click the  button 
- or - 
Press the <Page Down> key on your keyboard.

To decrease the number of grid lines:

Click the  button 
- or - 
Press the <Page Up> key on your keyboard.

Virtual display zoom

You can zoom in on the virtual display area to assist with accurately placing windows or you 
can zoom out to see more of the target display.

To zoom in on the display:

Click the  button. 
- or -  
From the View menu, select Zoom In. 
- or -  
Press the <+> key on your keyboard.

To zoom out of the display:

Click the  button. 
- or -  
From the View menu, select Zoom Out. 
- or -  
Press the <-> key on your keyboard.

NOTE:	 Zooming in on or out of the virtual display does not affect the content of the 
real display.

Quantum Control Software • Creating a Presentation 54



Background Color

In the virtual display area, you can change the color of the background and the virtual 
display itself.

NOTE:	 Changing the color of the virtual display has no effect on the content of the real 
display.

To change the background or virtual display color:

1.	 Right-click anywhere in the layout area (but not on a window) of the Scene Design 
workspace and select either Change Background Color or Change Virtual 
Display Color from the drop-down menu. The Color dialog opens.

2.	 Select a predefined or newly defined color.

3.	 Click OK.
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Viewing a 
Presentation

This section describes the Scene Control task and two methods of viewing scenes in a 
presentation. Topics that are covered include:

zz Using the Scene Control

zz Using Auto Play

Using the Scene Control
The Scene Control task lets you recall specific scenes in your presentation by clicking a scene 
control button on the computer screen. 

The layout and design of the buttons can be customized to suit the end user.

To access the Scene Control:

Click the Scene Control button on the taskbar. 

The Scene Control workspace and Views toolbar open.

Run View and Design View

There are two modes for the Scene Control workspace:

zz Run View

zz Design View

Run View

In Run View mode, the Scene Selection buttons are active. To recall a scene, click the 
appropriate Scene Selection button.

Here is an example of the Scene Control workspace in Run View:

Figure 35.	Scene Control Workspace in Run View
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Design View

In Design View mode, you can customize the layout and design of the Scene Selection 
buttons. To assist with button sizing and positioning, a layout grid is displayed. 

Here is an example of the Scene Control workspace in Design View:

Figure 36.	Scene Control Workspace in Design View

To toggle between Run View and Design View, click the  button on the Views toolbar.

Full Screen Mode

The Scene Control task can also be operated in full screen mode, in which only the 
workspace area, containing the Scene Selection buttons, is visible.

When full screen mode is active, the Scene Control automatically switches to Run View 
and access is disabled to all setup tasks. This mode is useful when the Quantum Control 
Software is to be controlled via a touch screen.

You can activate full screen mode from the Scene Control task as follows:

Click the  button on the Views toolbar.

To return to normal screen mode, press the <Esc> key on your keyboard.

Starting up in full screen mode

The Quantum Control Software can also open directly to full screen mode at startup. To do 
this, you need to create a Windows shortcut and specify a “switch” on the command line.

To start the Quantum Control Software in full screen mode:

1.	 Minimize (or close) the Quantum Control Software and any other Windows applications 
so that you can see the desktop.

2.	 Create a new shortcut by right-clicking the desktop and selecting New > Shortcut 
from the drop-down menu. The Create Shortcut dialog box opens.

3.	 Enter the command line. You can enter the path to the program or locate it by clicking 
the Browse button. In a typical installation, the command line is  
“C:\Program Files\Extron\Quantum Elite\Quantum Elite.exe” 
- or -  
“C:\Program Files\Extron\Quantum Connect\Quantum Connect.exe”

4.	 Add the characters -u to the end of the command line, leaving a space at the end of the 
program path.
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5.	 Click Next.

6.	 Enter the name for the shortcut or accept the default name and click Finish.

7.	 If you want the new shortcut to execute when the operating system starts, you need 
to copy or move the shortcut to the Windows Startup folder. See the Windows Help 
system for more information on how to do this.

Creating a Default Layout

You can have the Quantum Control Software create a default layout, comprising of a button 
for each scene in your presentation. Generally, this function is used to create a new layout 
and customize the layout as needed.

Any customized settings that you have already created are lost by using this function. 

To create a default layout:

1.	 Ensure that the Scene Control workspace is in Design View (the layout grid is visible).

2.	 Click the  button on the Views toolbar. A Warning dialog box opens with a 
reminder that any existing layout settings will be lost if you proceed.

3.	 In the Warning dialog box, click Yes to create a default layout or click No to retain the 
existing layout. 

Customizing the Layout

Changing background properties

You can set the background of the Scene Control workspace to be a solid color or a bitmap 
image.

To change the background:

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 Right-click anywhere on the workspace background (but not on a Scene Selection 
button). The Background Properties dialog opens.

 

Figure 37.	 Background Properties Dialog Box
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3.	 Apply a solid color or a bitmap image.  
To apply a solid color:

a.	 In the Background Properties dialog, click Colour. The Color dialog opens.

b.	 Select a predefined color from the Basic Colors palette or define a custom color.

c.	 Click OK. This returns you to the Background Properties dialog.

d.	 Click OK in the Background Properties dialog to apply the chosen color.

- or - 

To apply a bitmap image:

a.	 In the Background Properties dialog, click Bitmap Manager. The Bitmap Manager 
dialog opens.

b.	 In the Available Bitmaps list, select an image name. If there are no bitmaps listed or 
to add a new bitmap, see “Using the Bitmap Manager.”

c.	 Click OK. This returns you to the Background Properties dialog.

d.	 Click OK in the Background Properties dialog to apply the chosen image.

Moving and resizing a button
1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 Click a Scene Selection button. It is highlighted with a dotted outline and resizing 
handles.

Figure 38.	 Selecting a Scene Selection Button

3.	 Move and resize the button as needed. 

zz To resize the button, position the mouse pointer over one of the resizing handles 
and drag the button border to the desired position. The mouse pointer changes to a 
double arrow symbol, showing which direction the border can be moved.

zz To move the button, position the mouse pointer within the button and drag the 
button to a new location. The mouse pointer changes to a crossed arrow symbol.

By default, the button borders snap to the layout grid. You can temporarily disable grid snap 
by holding down the <Shift> key on your keyboard while moving or resizing the button.
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Changing the properties of a button

You can set the button background to be a solid color or bitmap image. You can also 
change the text displayed on the button, including the font style, size, and color. 

To open the Change Button Properties dialog:

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 Right-click the Scene Selection button. The Change Button Properties dialog opens.

Figure 39.	 Change Button Properties Dialog Box

To change the text and font displayed on the button:

1.	 In the Button Text field of the Change Button Properties dialog, enter the desired text.

NOTE:	 When the button is first created, the button text is copied from the scene 
title. Any subsequent change to the scene title does not update the button 
text.

2.	 Click Font to change the size, style, or color of the font. The Font dialog opens.

3.	 Change the font settings as desired.

4.	 Click OK. This returns you to the Change Button Properties dialog.

5.	 Click OK to apply the new text and font settings.

To apply a solid color to the button:

1.	 In the Change Button Properties dialog, click Color. The Color dialog opens.

2.	 Select a predefined color from the Basic Colors palette or define a custom color.

3.	 Click OK. This returns you to the Change Button Properties dialog.

4.	 Click OK to apply the selected color.
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To apply a bitmap image to the button:

1.	 In the Change Button Properties dialog, click Bitmap Manager. The Bitmap Manager 
dialog opens.

2.	 In the Available Bitmaps list, select an image name. If there are no bitmaps listed or to 
add a new bitmap, see “Using the Bitmap Manager.”

3.	 Click OK. This returns you to the Change Button Properties dialog.

4.	 Click OK to apply the selected image.

TIPS:	 •	 The edge color of a button is determined by the color applied to the entire 
button and remains visible when an image is used. 

•	 To improve the appearance of the button, first apply a color to the button that 
matches the color of the image, then apply the image. 

If you need to hide the button during Run View, select the Hide? check box in the Change 
Button Properties dialog.

Changing the properties of multiple buttons

You can change the properties (such as color and font size) of more than one button 
simultaneously. However, you cannot move or resize several buttons simultaneously.

To simultaneously change the properties of multiple buttons:

1.	 Ensure that the Scene Control workspace is in Design View (with the layout grid visible).

2.	 In the workspace, ensure that the mouse pointer is not over a Scene Selection 
button, then click and drag to draw a rectangle around the buttons you want to 
change. When you release the mouse button, all Scene Selection buttons within the 
rectangle are selected (with resizing handles).

3.	 Right-click on a button, if you want to copy the properties from that button. 
- or - 
Right-click anywhere else in the workspace, if you want to obtain the default properties. 

The Change Button Properties dialog opens and Multiple selection is shown in the 
preview section.

4.	 In the Change Button Properties dialog, make the necessary modifications to the font 
color, font typeface, button color and image.

NOTE:	 You cannot change the button text when selecting multiple buttons.

5.	 In the Change Button Properties dialog, click OK to apply the new properties to all 
buttons in the selection.
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Using the Bitmap Manager

Clicking Bitmap Manager in either the Background Properties dialog or the Change Button 
Properties dialog opens the Bitmap Manager dialog.

 

Figure 40.	Bitmap Manager Dialog Box

Any bitmaps (.bmp files) that are applied to the buttons or background of the Scene Control 
workspace are not saved with the presentation file. Instead, the files are copied to a separate 
folder on the hard drive from which the Quantum Control Software accesses them. 

NOTE:	 If you copy a presentation from one computer to another, you must remember 
to copy the bitmaps.

Any missing bitmaps are indicated on the appropriate button or background with a red X on 
a blue background.

Figure 41.	Missing Bitmap

To change the bitmap folder:

1.	 In the Bitmap Folder field of the Bitmap Manager dialog, click Browse. The Browse 
for Folder dialog opens.

2.	 Select the appropriate folder.

3.	 Click OK.

To select an existing bitmap:

1.	 In the Available Bitmaps list of the Bitmap Manager dialog, select the appropriate file.

2.	 Click OK.
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Adding, removing, or restoring a bitmap

To add a new bitmap:

1.	 In the Bitmap Manager dialog, click Add Bitmap. The Open dialog appears.

2.	 Locate the desired bitmap (.bmp) file.

3.	 Click OK. The bitmap file is copied to the directory specified in the Bitmap Folder field 
and appears in the Available Bitmaps list.

You can also copy files directly to the Bitmap folder using Windows Explorer. However, you 
need to close the Bitmap Manager dialog and reopen it to update the Available Bitmaps list.

When the Quantum Control Software is first installed, a number of sample background and 
button bitmaps are copied to the Bitmaps folder. By default, this folder is located in:

C:\Program Files\Extron\Quantum Elite

 - or - 

C:\Program Files\Extron\Quantum Connect

To remove a bitmap:

1.	 In the Available Bitmaps list of the Bitmap Manager dialog, select the appropriate file.

2.	 Click Remove Bitmap. 

If the file is currently in use, a Warning dialog box opens asking whether to delete the 
file. Click Yes to proceed. 

The file is deleted from the list and the bitmap folder. If the bitmap was in use by any 
buttons, the buttons now display a red X on a blue background (see figure 41). 

To restore a deleted bitmap:

Follow the instructions for adding a new bitmap (see the steps under “To add a new 
bitmap”). As long as the file name of the restored bitmap is the same as the missing 
bitmap, the image is restored to the appropriate button or background.

- or - 

Copy the missing file to the bitmap folder using Windows Explorer. You need to restart 
the Quantum Control Software to fully restore the bitmap image to the appropriate 
button or background.

Using Auto Play
When using the Auto Play function, the Quantum Control Software displays each scene for 
a specified period and automatically switches to the next scene. The period of time that a 
scene is displayed can be different for each scene.

When the presentation starts, it plays continuously until it is stopped. When the last scene is 
reached, Auto Play continues with the first scene.

To use Auto Play:

Click the Scene Design button on the taskbar to open the Scene Design task. 

The Scene Design workspace opens.

The main features and toolbars associated with the Scene Design workspace are shown in 
figure 20.
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Changing the Order of Scenes

In an Auto Play presentation, scenes are recalled in the order that they appear in the scene 
list of the Scene Design workspace.

To move a scene in the scene list:

Drag and drop the scene title to a new position in the list (see “Working with 
Scenes”).

Changing the Display Time for a Scene

You can choose whether or not a scene is included in an Auto Play presentation and the 
length of time that it is displayed by using the Scene Properties dialog.

To change the display time:

1.	 Click the Scene Design button on the taskbar.           

The Scene Design workspace (see figure 20) opens.

2.	 For the currently selected scene in the scene list, click the  button on the Scene 
toolbar.  
- or - 
For any other scene, right-click a scene title in the scene list.

The Scene Properties dialog opens. Ensure the Properties tab (see figure 21) is 
selected.

3.	 Modify the Auto Play Delay (mSec) setting, the Include Scene in Autoplay 
setting, and other settings as needed. The value in the Auto Play Delay (mSec) field 
is the amount of time that the scene is displayed in a presentation. The Include Scene 
in AutoPlay check box, if selected, includes the scene in an Auto Play presentation.

4.	 Click OK.

Starting and Stopping the Presentation

To start the presentation:

1.	 Click the Scene Design button on the taskbar.            

The Scene Design workspace (see figure 20) opens.

2.	 Click the  button on the Scene Control toolbar. The Autoplay mode dialog box 
opens while Auto Play is active:

Figure 42.	 Autoplay Mode Dialog Box
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The presentation plays continuously until it is stopped. When the presentation reaches the 
last scene, Auto Play returns to the first scene.

To stop the presentation:

Click the  button on the Scene Control toolbar. 

Changing the Playback Speed

When using Auto Play, the duration of displaying each scene is controlled by the Auto 
Play Delay setting in the Scene Properties dialog (see “Changing the Display Time for a 
Scene”). 

However, it is possible to speed up or slow down the rate of display across the entire 
presentation.

To change the playback speed:

Use the following buttons on the Scene Properties toolbar in the Scene Design task:

Button Function

Increases playback speed. Each click decreases the normal delay time* of 
each scene by 10 percent, thus increasing playback speed.

Decreases the playback speed. Each click increases the normal delay time* 
of each scene by 10 percent, thus decreasing the playback speed.

*The normal delay time is defined by the Auto Play delay value on the Scene Properties 
screen.

The current Auto Play time adjustment is displayed on the status bar, with the normal speed 
being 100 percent. For example:

Figure 43.	Scene Delay Information on Status Bar
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Serial Commands

This section describes the format of the serial data strings that can be transmitted or 
received by the Quantum Control Software. Topics that are covered include:

zz Control of External Devices

zz Remote Control of a Presentation

zz ASCII Character Chart

Control of External Devices
To enable the control of external devices, the external devices need to be connected to the 
Data TX output of the computer serial (RS-232) port.

These ports are usually identified as COMx where x is a number from 1 to 4 (such as 
COM2). You must ensure that the appropriate serial port is configured correctly by following 
the instructions in “Communications Setup.”

Serial data strings can be included within scenes (see “Scene Commands”). In a scene, 
three strings can be transmitted:

zz Pre Scene Commands — Commands that occur as soon as the scene is selected but 
not yet fully displayed.

zz Post Scene Commands — Commands that occur when the scene display is fully 
complete.

zz Exit Scene Commands — Commands that occur when another scene is selected but 
before the pre-scene commands of the new scene.

These commands can be used to control external source switchers or other RS-232 
controllable devices.
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Format of External Control Strings

The exact content of the serial data string depends on the device you are controlling. See the 
device user guide for more information.

A serial data string can comprise of ASCII text, hexadecimal data, and control characters. 
Pauses can also be inserted as necessary to fine tune the timing of the messages. See the 
chart below.

Data String Transmitted 
Information

Text characters using the computer keyboard. Text Character

A caret (^) followed by the control character. 
For example: ^M effectively sends a “carriage return.” For 
letters, use only uppercase characters.

Control Character

The hex pair preceded by a caret (^) and an “at” sign (@). 
For example: ^@4B^@24 transmits hex 4B and hex 24 (ASCII 
characters K and $)

Hex Data

A caret (^) followed by a comma. This delays transmission of 
subsequent characters in the string by 100 milliseconds. Pauses 
can be stacked to create longer delays. 
For example: ^,^,^,^,^, gives a delay of 500 milliseconds 
(0.5 seconds).

A Pause

Examples of external control strings

Example 1: AUXB12^M

This transmits AUXB12 out of the serial port and terminates with a ^M (carriage return).

Example 2: ^@C0^@00^@02^@00^@15^,^,^,2!^C

This transmits the hex characters C0 00 02 00 15, pauses for 300 milliseconds, and then 
sends the ASCII character 2! followed by a ^C (break).

NOTES:	 Most devices expect some kind of termination character at the end of a control 
string. ^C (break) or ^M (carriage return) are used most frequently; however, 
this is dependant on the hardware you are controlling. There is no standard for 
termination characters.

Any spaces entered within the data string are transmitted just like any other 
character. You should, therefore, avoid entering or leaving spaces in a data 
string, unless they are specifically required by the receiving device. 
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Remote Control of a Presentation
Remote control of a presentation is achieved by sending R-type messages to the Data RX 
input on one of the serial (RS-232) ports of the computer.

Alternatively, R-type messages can be created as simple ASCII text strings and transmitted 
using suitable software, such as a terminal emulation program or a control system.

You can use the external control capability of a presentation. See “Control of External 
Devices” for information about remotely controlling another presentation running on a 
different computer.

R-type Message Format

The standard R-type message structure is shown below with examples in ASCII format, 
hexadecimal format, and mixed hex and ASCII format (see the ASCII Character Chart for 
reference).

A command string is contructed in the following format:

SOH R Data STX Command ETB ETX

Portions of the command string are defined as follows:

SOH (Start of Header) In hex, this is 01. In ASCII, this is ^A.

R This portion of the command string signifies that the message is an R-Type 
command.

Data This portion consists of the information to be executed. This information 
is optional and is only required if the specific remote control command 
requires additional information, such as a show name, to properly execute 
the command.

STX (Start of Transmission) In hex, this is 02. In ASCII, this is ^B.

Command This portion contains the remote command type.

ETB (End of Block) In hex, this is 17. In ASCII, this is ^W.

ETX (End of Transmission) In hex, this is 03. In ASCII, this is ^C.

The contents of the portions denoted by Data and Command vary according to the required 
function and can be determined from the command table. Hex portions in a command 
string are denoted in brackets. 

NOTE:	 The spaces between characters are included for clarity only and must not appear 
in the transmitted message. The only permitted spaces within a string are in 
scene names.

The following example is a remote control string in ASCII format. This example runs a scene 
with the name “ATTRACT”: 
	 ^A R ATTRACT ̂ B 07 ̂ W ̂ C

The hex version of the above command string is: 
	 [01][52][41][54][54][52][41][43][54][02][30][37][17][03]

A more common approach (compared to creating a string entirely in hex pairs or in ASCII), 
is to mix hex and ASCII data. This makes the string more readable. The mixed version of the 
above command string is: 
	 [01] R ATTRACT [02] 07 [17] [03] 
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Command Symbol Definitions
X50!	 =	 Scene location in list (1 to 999)

X50@	 =	 Scene name (ASCII, case-sensitive)

X50#	 =	 Window number (0000 to 0998,  
zero-based, leading zeros required) 
Example: Window 25 = 0024

X50$	 =	 Zoom percentage (000 to 999, leading zeros 
required) 
000 = No zoom 
500 = Zoom into 50 percent of image

X50%	 =	 Pan horizontal location (000 to 999, leading 
zeros required) 
000 = Left-most edge of input video 
500 = Middle of image horizontally

X50^	 =	 Pan vertical location (000 to 999, leading zeros 
required) 
000 = Top-most edge of input video 
500 = Middle of image vertically

X50&	 =	 Window horizontal position (-9999 to 99999, 
leading zeros required) 
-0500 = 500 pixels off screen to the left 
01920 = 1920 pixels to the right of 
              the left-most border

Command Table
Command ASCII Description

Recall Scene

Recall by list position [01] R X50! [02] 05 [17] [03] Recalls scene number X50! according to 
the scene list

Example: [01] R Ø4 [02] 05 [17] [03] Recalls the fourth scene in the list in the 
Scene Design task

Recall by scene name [01] R X50@ [02] 07 [17] [03] Recalls scene X50@ 

Example: [01] R PRESET 2 [02] 07 [17] [03] Recalls scene named “PRESET 2”

Recall next scene [01] R [02] 0n [17] [03] Recalls next scene in the list

Recall previous scene [01] R [02] 0p [17] [03] Recalls previous scene in the list

Window Source

Select input [01] R X50# X51! [02] 36 [17] [03] Selects input X51! to be shown in 
window X50# 

Example: [01] R 0004 Laptop Input [02] 36 [17][03] Sets window 5 to display source named 
“Laptop Input”

Select input in named 
scene

[01] R X50@,X50#,X51! [02] 52 [17] [03] Routes input X51! to window X50# in 
scene X50@.

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Autorun Controls

Begin from 1st scene [01] R [02] 0= [17] [03] Begin the autorun sequence with first 
scene in the list

Begin from current 
scene

[01] R [02] 0> [17] [03] Begin the autorun sequence from 
currently displayed scene

Increase autorun 
speed

[01] R [02] 0+ [17] [03] Increase the duration by 10 percent for 
each scene to be displayed

Decrease autorun 
speed

[01] R [02] 0- [17] [03] Decrease the duration by 10 percent for 
each scene to be displayed

Stop autorun 
sequence

[01] R [02] 0< [17] [03] Halts the autorun sequence

X50*	 =	 Window vertical position (-9999 to 99999, leading 
zeros required) 
-0500 = 500 pixels above the top edge of 
              the screen 
01080 = 1080 pixels to below the top border

X50(	 =	 Window horizontal size (00000 to 99999, leading 
zeros required) 
00400 = 400 pixels wide

X51)	 =	 Window vertical size (00000 to 99999, leading zeros 
required) 
00300 = 300 pixels tall

X51!	 =	 Input source name (ASCII, case-sensitive)

X51@	 =	 Window style name (ASCII, case-sensitive)

X51#	 =	 Border or overlay onscreen text (ASCII,  
case-sensitive)

X51$	 =	 Merge scene name (ASCII, case-sensitive)

X51%	 =	 Window layer number (0 to 999)

X51^	 =	 File location including the full directory path.  
Example: C:\Files\TestShow 
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Command ASCII Description

Window Visibility

Hide Window [01] R X50# 0 [02] 33 [17] [03] Sets window X50# to be hidden

Example: [01] R 00050 [02] 33 [17] [03] Sets window 6 to be hidden

Hide Multiple 
Windows

[01] R X50@,X50#,X50#,0 [02] 63 [17] [03] Sets window X50# through X50# in scene 
X50@ to be hidden

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Show Window [01] R X50# 1 [02] 33 [17] [03] Sets window X50# to be shown

Example: [01] R 00051 [02] 33 [17] [03] Sets window 6 to be shown

Show Multiple 
Windows

[01] R X50@,X50#,X50#,1 [02] 63 [17] [03] Sets window X50# through X50# in scene 
X50@ to be shown

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Window Size and Position

Set size and position [01] R X50# X50& X50* X50( X51) [02] 35 [17] [03] Sets window X50# to position ( X50&, 
X50* ) and size X50( by X51) 

Example: [01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03] Sets window 5 to position (300, 400) and 
size 800x600

Set parameters in 
named scene

[01] R X50@,X50# X50& X50* X50( X51) [02] 57 [17] [03] Sets window X50# in scene X50@ to 
position ( X50&, X50* ) and size X50( by 
X51) 

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Window Priority

Bring window to 
front

[01] R X50@,X50#,1 [02] 78 [17] [03] Brings window X50# to be in front of all 
windows

Send window to back [01] R X50@,X50#,0 [02] 78 [17] [03] Sends window X50# behind all windows

Example: [01] R PRESET 2,0004,1 [02] 78 [17] [03] Sets window 5 in scene “PRESET 2” to be 
in front

Bring window 
forward

[01] R X50@,X50#,X51%, 1 [02] 79 [17] [03] Brings window X50# forward X51% layers

Send window 
backward

[01] R X50@,X50#,X51%, 0 [02] 79 [17] [03] Sends window X50# backward X51% layers

Example: [01] R PRESET 2,0004,3,0 [02] 79 [17] [03] Sends window 5 in scene “PRESET 2” 
backward 3 layers

NOTE:	 X50@  = Scene name (ASCII, case-sensitive) 
X50#  = Window number (0000 to 0998, zero-based, leading zeros required) 
X50&  = Window horizontal position (-9999 to 99999, leading zeros required) 
X50*  = Window vertical position (-9999 to 99999, leading zeros required) 
X50(  = Window horizontal size (00000 to 99999, leading zeros required) 
X51)  = Window vertical size (00000 to 99999, leading zeros required) 
X51%  = Window layer number (0 to 999)
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Command ASCII Description

Zoom and Pan

Set zoom and pan [01] R X50# X50$ X50% X50^ [02] 34 [17] [03] Sets window X50# to have a zoom of 
X50$ and pan of X50% and X50^ 

Example 1: [01] R 0004 500 000 000 [02] 34 [17] [03] Sets window 5 to zoom into 50 percent 
of the imge and to display the top left

Example 2: [01] R 0004 750 750 750 [02] 34 [17] [03] Sets window 5 to zoom into 25 percent 
of the image and to display the bottom 
right

Set Parameters in 
named scene

[01] R X50@,X50# X50$ X50% X50^ [02] 58 [17] [03] Sets window X50# in scene X50@ to have a 
zoom of X50$ and a pan of X50% and X50^ 

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Coordinate system:

The horizontal and vertical pan settings allow you to position the  
upper left corner of the zoomed region on a 1000 x 1000 grid that  
represents the original image. 

Window Style

Select style [01] R X50# X51@ [02] 37 [17] [03] Sets window X50# to use predefined style 
X51@ 

Example: [01] R 0004 Arial 2 [02] 37 [17] [03] Sets window 5 to use window style 
named “Arial 2”

Select style in named 
scene

[01] R X50@,X50#,X51@ [02] 53 [17] [03] Sets window X50# in scene X50@ to use 
style X51@ 

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Define border text [01] R X50# X51# [02] 38 [17] [03] Sets window X50# to have border text 
which states X51# 

Example: [01] R 0004 Auxiliary Input [02] 38 [17] [03] Sets window 5 to have border text stating 
“Auxiliary Input”

Set border text in 
named scene

[01] R X50@,X50#,X51# [02] 54 [17] [03] Sets window X50# in scene X50@ to have 
border text X51# 

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

NOTE:	 X50@  = Scene name (ASCII, case-sensitive) 
X50#  = Window number (0000 to 0998, zero-based, leading zeros required) 
X50$  = Zoom percentage (000 to 999, leading zeros required) 
X50%  = Pan horizontal location (000 to 999, leading zeros required) 
X50^  = Pan vertical location (000 to 999, leading zeros required) 
X51@  = Window style name (ASCII, case-sensitive) 
X51#  = Border or overlay onscreen text (ASCII, case-sensitive)
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Command ASCII Description
Define overlay text [01] R X50# X51# [02] 39 [17] [03] Sets window X50# to have overlay text 

stating X51# 

Example: [01] R 0004 CONFIDENTIAL [02] 39 [17] [03] Sets window 5 to have overlay text 
stating “CONFIDENTIAL”

Set overlay text in 
named scene

[01] R X50@,X50#,X51# [02] 55 [17] [03] Sets window X50# in scene X50@ to have 
overlay text X51# 

NOTE:	 If using merge scenes, X50@ needs to be remerged for change to occur.

Batch Execute Commands

Begin command 
collection

[01] R [02] 41 [17] [03] All commands after this string will be 
collected but not executed

Execute collected 
commands

[01] R [02] 42 [17] [03] Execute all commands issued between the 
Begin and Execute strings

Example: [01] R [02] 41 [17] [03]
[01] R PRESET 2 [02] 07 [17] [03]
[01] R 0004 Laptop Input [02] 36 [17] [03]
[01] R 0004 CONFIDENTIAL [02] 38 [17] [03]
[01] R [02] 42 [17] [03]

Begin collecting commands. The 
following 3 commands would be 
executed simultaneously after the last line 
is sent:

zz Recall scene named “PRESET 2.”

zz Set window 5 to display source named 
“Laptop Input.”

zz Set window 5 to have overlay text 
stating “CONFIDENTIAL.”

Merge Scene Controls

Create merge scene [01] R X51$,,,1 [02] 51 [17] [03] Creates a new merged scene named X51$ 

Add or remerge scene [01] R X51$,,X50@,1 [02] 51 [17] [03] Adds or remerges existing scene X50@ to 
merge scene X51$ 

Delete scene [01] R X51$,X50@,,1 [02] 51 [17] [03] Removes scene X50@ from merge scene 
X51$ 

Purge merge scene [01] R [02] 56 [17] [03] Removes all windows from the current 
merge scene

[01] R X51$ ,,,1 [02] 51 [17] [03] Refreshes merge scene X51$ to have all 
windows removed

Save Current Show to File

Save current show [01] R X51^ [02] 11 [17] [03] Saves current show to X50# (includes 
directory path)

Example: [01] R C:\Files\TestShow [02] 11 [17] [03] Saves current show to C:\Files with a 
filename of “TestShow”

NOTE:	 X50@  = Scene name (ASCII, case-sensitive) 
X50#  = Window number (0000 to 0998, zero-based, leading zeros required) 
X51#  = Border or overlay onscreen text (ASCII, case-sensitive) 
X51$  = Merge scene name (ASCII, case-sensitive) 
X51^  = File location including the full directory path
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Examples of R-type Messages

The following examples of R-type messages assume that there are five scenes in the currently 
loaded presentation and that they appear in the scene list as:

zz Intro

zz Video

zz Demo

zz Conference

zz Finish

NOTE:	 The spaces between characters are included for clarity only and must not appear 
in the transmitted message.

To select the Conference scene by its name: 
	 ^AR Conference ̂ B 07 ̂ W^C

To select the Demo scene by its position in the scene list: 
	 ^AR 3 ̂ B 05 ̂ W^C

To select the next scene in the scene list: 
	 ^AR ̂ B 0n ̂ W^C

To start AutoPlay from the first scene (in this case, the Intro scene): 
	 ^AR ̂ B 0= ̂ W^C

To stop AutoPlay: 
	 ^AR ̂ B 0< ̂ W^C

To increase AutoPlay playback speed by 10 percent: 
	 ^AR ̂ B 0+ ̂ W^C

To hide or show window 7 in the current scene: 
	 ^AR 0006 0 ̂ B 33 ̂ W^C (hides the window) 
	 ^AR 0006 1 ̂ B 33 ̂ W^C (shows the window)

To set window 4 to the “Warning” style: 
	 ^AR 0003 Warning ̂ B 37 ̂ W^C

To set the overlay text of window 4 to read “Incident Reported”: 
	 ^AR 003 Incident Reported ̂ B 39 ̂ W^C

To set the viewport of window 5 to show a magnified area from the center of the 
source image: 
	 ^AR 0004 500 250 250 ̂ B 34 ̂ W^C
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Merge scene commands (51-56) provide independent control of areas on a display wall that 
are driven from a Quantum processor or array of processors. This is useful for installations 
where more than one operator needs access to the display wall. See “Working with Merge 
Scenes” for more information about merge scene functions.

A merge scene allows sources on different areas of the display wall to be merged into the 
overall scene.

To create a merge scene called “Merge Scene”: 
	 ^AR Merge Scene,,,1 ̂ B 51 ̂ W^C

To add a scene called “Op 1 scene 1” in “Merge Scene”: 
	 ^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C 

NOTE:	 “Op1 scene 1” must already be created in the Quantum Control Software.

To remove the “Op1 scene 1” scene and add the “Op1 scene 2” scene to the merge 
scene: 
	 ^AR Merge Scene,,Op1 scene 1,Op1 scene 2,1 ̂ B 51 ̂ W^C

To change the source that is applied to a certain window in a scene, two commands are 
sent: 
	 ^AR Op1 scene 2,0,New Source 1 ̂ B 52 ̂ W^C (applies “New Source 1”  
	 source to window “0” in the “Op1 scene 2” scene) 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C (refreshes the merged  
	 scene)

To change the window style, use command 53 and refresh the merge scene: 
	 ^AR Op1 scene 2,0, Arial 1 ̂ B 53 ̂ W^C 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C

To change the border text on a window, use command 54 and refresh the merge scene: 
	 ^AR Op1 scene 2,0, Camera 15 ̂ B 54 ̂ W^C 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C

To change the overlay text on a window, use command 55 and refresh the merge 
scene: 
	 ^AR Op1 scene 2,0, Camera 15 ̂ B 55 ̂ W^C 
	 ^AR Merge Scene,,Op1 scene 2,1 ̂ B 51 ̂ W^C

To remove all of the windows from the merge scene, use the Purge scene command 
(56) and refresh the scene: 
	 ^AR ̂ B 56 ̂ W^C 
	 ^AR Merge Scene,,,1 ̂ B 51 ̂ W^C
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ASCII Character Chart
The ASCII character chart below is provided as a reference for creating your serial data 
strings.

Dec Hex ASCII CTRL 
Key

Dec Hex ASCII Dec Hex ASCII Dec Hex ASCII

0 0 NULL ^@ 32 0x20 <SPACE> 64 0x40 @ 96 0x60 `

1 1 SOH ^A 33 0x21 ! 65 0x41 A 97 0x61 a

2 2 STX ^B 34 0x22 “ 66 0x42 B 98 0x62 b

3 3 ETX ^C 35 0x23 # 67 0x43 C 99 0x63 c

4 4 EOT ^D 36 0x24 $ 68 0x44 D 100 0x64 d

5 5 ENQ ^E 37 0x25 % 69 0x45 E 101 0x65 e

6 6 ACK ^F 38 0x26 & 70 0x46 F 102 0x66 f

7 7 BEL ^G 39 0x27 ‘ 71 0x47 G 103 0x67 g

8 8 BS ^H 40 0x28 ( 72 0x48 H 104 0x68 h

9 9 HT ^I 41 0x29 ) 73 0x49 I 105 0x69 i

10 A LF ^J 42 0x2A * 74 0x4A J 106 0x6A j

11 B VT ^K 43 0x2B + 75 0x4B K 107 0x6B k

12 C FF ^L 44 0x2C , 76 0x4C L 108 0x6C l

13  D CR ^M 45  0x2D - 77 0x4D M 109 0x6D m

14 E SO ^N 46 0x2E . 78 0x4E N 110 0x6E n

15 F SI ^O 47 0x2F / 79 0x4F O 111 0x6F o

16 10 DLE ^P 48 0x30 0 80 0x50 P 112 0x70 p

17 11 DC1 ^Q 49 0x31 1 81 0x51 Q 113 0x71 q

18 12 DC2 ^R 50 0x32 2 82 0x52 R 114 0x72 r

19 13 DC3 ^S 51 0x33 3 83 0x53 S 115 0x73 s

20 14 DC4 ^T 52 0x34 4 84 0x54 T 116 0x74 t

21 15 NAK ^U 53 0x35 5 85 0x55 U 117 0x75 u

22 16 SYN ^V 54 0x36 6 86 0x56 V 118 0x76 v

23 17 ETB ^W 55 0x37 7 87 0x57 W 119 0x77 w

24 18 CAN ^X 56 0x38 8 88 0x58 X 120 0x78 x

25 19 EM ^Y 57 0x39 9 89 0x59 Y 121 0x79 y

26 1A SUB ^Z 58 0x3A : 90 0x5A Z 122 0x7A z

27 1B ESC ^[ 59 0x3B ; 91 0x5B [ 123 0x7B {

28 1C FS ^\ 60 0x3C < 92 0x5C \ 124 0x7C |

29 1D GS ^] 61 0x3D = 93 0x5D ] 125 0x7D }

30 1E RS ^^ 62 0x3E > 94 0x5E ^ 126 0x7E ~

31 1F US ^_ 63 0x3F ? 95 0x5F _ 127 0x7F <DEL>
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Access Control

This section describes access control that is incorporated in the Quantum Control Software, 
allowing different operators to gain access to different tasks. Topics that are covered include:

zz Login Procedure

zz Enabling and Disabling Access Control

zz Changing Role Passwords

Login Procedure
The Quantum Control Software incorporates an access control system that allows different 
operators to have access to different tasks according to their needs and responsibility. This 
feature helps to prevent end users from being able to accidentally or deliberately change the 
setup of the Quantum Control system.

The following table lists the three operator roles available along with the tasks that are 
accessible to each role. 

Task Operator Role

Administrator Designer User

Choose Display Processors X X

Choose Layout X

Communications Setup X

Set Up Sources X

Scene Design X X

Scene Control X X X  
(see note below)

Remote Access Setup X

NOTE:	 When you log in as a User, the Scene Control task opens in full screen mode 
(Run View only, not Design View). To return to normal screen mode (such as to 
adjust the brightness setting), press the <Esc> key on the keyboard. To return to 
full screen mode, click the Scene Control button on the taskbar.

With the access control feature enabled, a Login dialog box opens each time you start the 
Quantum Control Software (see figure 44).
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Figure 44.	Login Dialog Box

To log in to the Quantum Control Software:

1.	 From the User drop-down list, select the desired role.

2.	 In the Password field, enter the required password for the chosen role.

3.	 Click OK or press the <Enter> key on the keyboard to continue. The  
Quantum Control Software splash screen appears for a few seconds, followed by the 
main application window (see “Main Application Window”).

NOTES:	 •	 By default, the password for each operator role is the same as the user name. 
For example, for the User role, the password is User.

•	 Passwords are case-sensitive.

Enabling and Disabling Access Control
Following a new installation of the Quantum Control Software, the access control system is 
disabled. Anyone using the application has access to all areas of functionality.

NOTE:	 Access control can be enabled by any user. However, after it has been enabled, it 
can only be disabled by an Administrator.

To enable access control:

From the Access Control menu, select Enable Access Control. Access control is 
enabled the next time you close and restart the Quantum Control Software.

To disable access control:

1.	 Start the Quantum Control Software application and log in as an Administrator  
(see “Login Procedure”).

2.	 From the Access Control menu, select Disable Access Control. Access control is 
disabled the next time that the Quantum Control Software is closed and restarted.
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Changing Role Passwords
By default, the password for each operator role is the same as the role name. For example, 
for the User role, the password is User.

NOTE:	 Passwords are case-sensitive. For example, if the password is User, entering 
user or USER is not recognized.

It is recommended that the default passwords are changed as soon as possible after 
installation. A password can contain any standard keyboard letters, numbers, or symbols and 
can be any length.

Passwords can only be changed by an Administrator, following the login procedure.

To change a role password:

1.	 Start the Quantum Control Software and log in as an Administrator.

2.	 From the Access Control menu, select Change Access Passwords. The Change 
Passwords dialog box opens.

Figure 45.	 Change Passwords Dialog Box

3.	 From the Role drop-down list, select the appropriate operator role.

4.	 The current password for that role appears in the Password field. Change the password 
as needed.

5.	 Click OK to save the new password or click Cancel to retain the existing password. The 
new password takes effect the next time you close and restart the Quantum Control 
Software.
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Appendix

This section discusses how to apply window styles to source windows on a Quantum display 
by modifying the XML file installed with the Quantum Control Software. This section also 
explains merge scene functionality and how to assign IP addresses for your devices. Topics 
that are covered include:

zz Modifying WIndow Styles

zz Working with Merge Scenes

zz IP Addressing

Modifying Window Styles

Overview

The Quantum Control Software allows you to apply window styles to source windows on a 
Quantum display. Styles allow source windows to have the following features:

zz Border of a specified color and width

zz Title bar of a specified font, size, and color

zz Text overlay of a specified font, size, and color

Title text displays on a solid background that is the same color as the border. Overlay text is 
text that is placed on top of the source image and does not have a background.

NOTE:	 Although a window can have both overlay text and title text at the same time, 
typically only one or the other is used. 

Styles are defined by an XML file that is installed on the PC hard disk when you install the 
Quantum Control Software. You can add new styles or modify existing styles by editing the 
XML file.

NOTES:	 •	 If you reinstall the Quantum Control Software at any time, the XML file will be 
overwritten with the default version and any changes that you made will be 
lost. Always keep a backup copy of the XML file. The XML file is a separate file 
and is not part of the presentation (.ctp) file. Copying shows between different 
computers requires both files to be copied.

•	 After reinstalling the Quantum Control Software, always replace the default 
XML file with your customized XML file before starting the Quantum Control 
Software.

•	 Otherwise, if you start the application with a presentation file that refers to 
non-existent styles, the missing styles are removed from all affected windows. 
If the show file is saved at this point, it is saved without the required styles. If 
you reinstall the correct XML file at this point, you need to manually reapply 
the missing styles to each affected window in the presentation file.
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Locating and Opening the XML File

You can edit the XML file using Microsoft Notepad or a proprietary XML editor if available.

To edit the file using Notepad:

1.	 From the desktop, click Start > All Programs > Accessories > Notepad. This 
opens the Notepad application.

2.	 From the File menu, select Open. The Open dialog box is displayed.

3.	 From the Files of type drop-down list, select All Files.

4.	 Browse to and select the XML file. By default, the file is located in the following folder 
on the computer hard disk: 
C:\Program Files\Extron\Quantum Elite\XML\ Quantum Source Types 
- or - 
C:\Program Files\Extron\Quantum Connect\XML\ Quantum Source Types  
The file is called ESQuantumConfig.xml.

5.	 Click Open.

The XML file looks similar to the following:

Figure 46.	ESQuantumConfig.xml File

NOTE:	 Before you make any changes to this file, it is strongly recommended that you 
create a backup copy. From the File menu, select Save As to open the Save As 
dialog and save a backup copy.

TIP:	 To make the text easier to read in Notepad, it is recommended that you turn off the 
Wordwrap feature (via the Format menu).

In the file, scroll down to the <WindowStyles> (opening) tag. The lines of information 
between this tag and the </WindowStyles> (closing) tag define all of the styles that appear 
in the Quantum Control Software.
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Overview of the Style Tag

Each style is defined with a separate <Style> tag. For example, the tag for the default style  
is defined by:

<Style Id=”Default” Name=”Default Style”> 
<Title Show=”1” Font=”Verdana” Size=”14” Bold=”1” HorizPosition=”Centre” 
VertPosition=”Bottom” Colour=”153,204,255” Flash=”0”/> 
<Overlay Show=”1” Font=”Verdana” Size=”14” Bold=”1” HorizPosition=”Left” 
VertPosition=”Bottom” Colour=”153,204,255” Flash=”0”/> 
<Border Show=”0” Colour=”51,51,51” Thickness=”2” Flash=”0”/> 
</Style>  

In the <Style Id=”Default” Name =”Default Style”> line of the example:

Name is the name of the style as it will appear on the Window Styles tab of the 
Window Properties dialog box in the Quantum Control Software. 
Id is a short name or reference for the style and identifies the style in RS-232 control 
messages.

The <Title> tag defines the attributes of the title bar, including font style, size, and color:

<Title Show=”1” Font=”Verdana” Size=”14” Bold=”1” 
HorizPosition=”Centre” VertPosition=”Bottom” Colour=”153,204,255” 
Flash=”0”/>

The <Overlay> tag defines the attributes of the border:

<Overlay Show=”1” Font=”Verdana” Size=”14” Bold=”1” 
HorizPosition=”Left” VertPosition=”Bottom” Colour=”153,204,255” 
Flash=”0”/>   

The <Border> tag defines the attributes of the border:

<Border Show=”0” Colour=”51,51,51” Thickness=”2” Flash=”0”/>  

The </style> tag is the closing tag.

Many of the attributes are common to each tag and are listed in the table in “Summary of 
style attributes.”
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Summary of style attributes

Attribute Function Values

Show Sets the text or border as visible or 
hidden

zz 0 = hidden

zz 1 = visible

Font The font name chosen from the 
fonts that are installed on the 
Quantum processor

Default fonts are:

zz Arial

zz Verdana

zz Microsoft Sans Serif

zz Tahoma

Size Sets the size of the font. The 
larger the number, the bigger the 
text.

Depends on display resolution and 
size. Typically, a value between 10 
and 40 provides readable results.

Bold Sets the font weight zz 0 = normal

zz 1 = bold

HorizPosition Defines the horizontal alignment 
of the text

zz Left

zz Centre

zz Right

VertPosition Defines the vertical alignment of 
the text

zz Top

zz Centre

zz Bottom

NOTE:	 Center alignment is not 
applicable to title text.

Thickness Defines the width of the border Width in pixels, typically between 
1 and 10 are acceptable values.

Colour Defines the color of the text or 
border using RGB colors

Values between 0 and 255:

zz 0,0,0 = black

zz 255,255,255 = white

zz 255,0,0 = red

zz 0,255,0 = green

zz 0,0,255 = blue

Flash Defines whether the text or 
border is static or flashing.

zz 0 = static

zz 1 = flashing
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Modifying an Existing Style

To modify an existing style:

1.	 Edit the appropriate attributes as needed.

For example, to change the default style to use Arial font on the title bar with the text 
aligned to the left, change the attribute values shown in italics:

<Style Id=”Default” Name=”Default Style”> 
<Title Show=”1” Font=”Arial” Size=”14” Bold=”1” HorizPosition=”Left” 
VertPosition=”Bottom” Colour=”153,204,255” Flash=”0”/> 
<Overlay Show=”1” Font=”Verdana” Size=”14” Bold=”1” 
HorizPosition=”Left” VertPosition=”Bottom” Colour=”153,204,255” 
Flash=”0”/> 
<Border Show=”0” Colour=”51,51,51” Thickness=”2” Flash=”0”/> 
</Style> 

2.	 From the File menu in Notepad, select Save to save any changes that you made.

3.	 Restart the Quantum Control Software to load the new style.

Adding a New Style

The easiest way to add a new style is to copy and paste an existing style, then modify it.

For example, to create a new style called My Style with the following attributes:

Attribute Value

Title Bar Text

Font Tahoma

Size 12

Bold No

Position Top Right

Colour Yellow (240,240,0)

Overlay Text

Font Tahoma

Size 12

Bold No

Position Centre

Colour Red (240,0,0)

Border
Width 3

Colour Gray (128,128,128)
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1.	 Select an existing style in the XML file.

NOTE:	 You must include the opening and closing Style tag.

Figure 47.	 Selecting an Existing Style in the XML File

2.	 Right-click the selected text and select Copy from the drop-down menu.

3.	 Paste the selected text between Style tags (after a </Style> tag and before the 
<Style> tag that follows it). To do so:

a.	 Press the <Enter> key on your keyboard after a </Style> tag. This moves the 
cursor to a new line above the next <Style> tag.

b.	 Press the <Tab> key on your keyboard to align the cursor with the previous  
</Style> tag.

c.	 RIght-click in the blank line and select Paste from the drop-down menu.

4.	 Modify the copied style to reflect the necessary attributes (see the table preceding these 
steps). The text for the new style appears as follows:

<Style Id=”MyStyle” Name=”My Style”> 
<Title Show=”1” Font=”Tahoma” Size=”12” Bold=”0” 
HorizPosition=”Right” VertPosition=”Top” Colour=”240,240,0” 
Flash=”0”/> 
<Overlay Show=”1” Font=”Tahoma” Size=”12” Bold=”0” 
HorizPosition=”Centre” VertPosition=”Centre” Colour=”240,0,0” 
Flash=”0”/> 
<Border Show=”0” Colour=”128,128,128” Thickness=”3” Flash=”0”/> 
</Style>  

5.	 From the File menu in Notepad, select Save to save any changes that you made.

6.	 Restart the Quantum Control Software to load the new style.
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Working with Merge Scenes

Merge Scene Overview

A merge scene allows sources on different areas of a display wall to be merged into the 
overall scene. The merge scene acts as a master scene while other scenes acts as subscenes. 
Each subscene is unique and is managed independently from one another. This is useful 
when dividing the pixel map into logical groups or display areas for independent control.

An overview of the merge scene workflow is:

1.	 Define the independent displays or display groups and allocate one or more subscenes 
for each.

2.	 Program and control the subscenes as needed.

3.	 Add or remove subscene data to or from the merge scene.

4.	 Refresh the merge scene. This is required in order for merge scene changes to take 
effect.

Defining Displays or Display Groups

To create a merge scene, define which displays or display groups are to be independently 
controlled. 

In the following example, there are nine display groups:

zz Display group 1 is a 2x4 videowall.

zz Display group 2 through 9 are independent LCD panels.

In the following figure, the display groups are shown in white.

Figure 48.	Display Groups
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Programming Subscenes

After you define the display groups, create the subscenes that belong to each group. In the 
following examples, screen group 1 (see figure 48) has eight subscenes titled Videowall1 
through Videowall8. Each subscene has a unique layout.

Figure 49.	Videowall1 Subscene

Figure 50.	Videowall2 Subscene
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Figure 51.	Videowall3 Subscene

Screen group 2 has three subscenes, LCD1-1 through LCD1-3, allocated to it. Each subscene 
is programmed to have a unique layout as shown in the following examples.

Figure 52.	LCD1-1 Subscene
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Figure 53.	LCD1-2 Subscene

Figure 54.	LCD1-3 Subscene

The remaining subscenes (subscene 3 through subscene 9), are allocated to the remaining 
LCD displays (LCD2 through LCD8). These subscenes follow the same convention as 
subscene 2 (LCD1).

Workflow

The merge scene should be the only scene that is running (active) in the Quantum Control 
Software. The merge scene is highlighted in the scene list to indicate that it is the currently 
active scene.

NOTE:	 All control commands are to be directed to a specific subscene, not to the merge 
scene.
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The following example workflow uses the previous subscene examples. 

1.	 Add a subscene to a merge scene. This essentially calls or runs the subscene.

For example, add Videowall1 to Merge Scene: 
[01] RMerge Scene,,Videowall1,1 [02] 51 [17] [03]

2.	 Make the desired changes to a subscene.

For example, set Videowall1/Window1 to SourceRGB1: 
[01] RVideowall1,0,RGB1 [02] 52 [17] [03]

3.	 Update the merge scene with the changed information from step 2, above.

NOTE:	 This step is required in order for changes to take effect.

For example, the following adds Videowall1 to the merge scene and applies updated 
subscene information: 
[01] RMerge Scene,,Videowall1,1 [02] 51 [17] [03]

4.	 Change one scene to the next scene.

For example, remove Videowall1 and add Videowall2: 
[01] RMerge Scene,Videowall1,Videowall2,1 [02] 51 [17] [03]

The window index numbers in the merge scene increment dynamically. The window index 
numbers in the subscene are left unchanged. 

When making several changes to a subscene, it may be more efficient to wait until all of the 
changes have been made before executing a final refresh of the merge scene.

For example:

Videowall1/Window1 set to SourceRGB1 
Videowall1/Window2 set to SourceRGB2 
Videowall1/Window3 set to SourceRGB3

[01] RVideowall1,0,RGB1 [02] 52 [17] [03] 
[01] RVideowall1,1,RGB3 [02] 52 [17] [03] 
[01] RVideowall1,3,RGB3 [02] 52 [17] [03] 
[01] RMerge Scene,,Videowall1,0 [02] 51 [17] [03] 
[01] RMerge Scene,,,1 [02] 51 [17] [03]

It may be beneficial to write a subroutine that will track which subscene is currently running 
when changing scenes. The subroutine indicates the subscene that needs to be removed 
from the merge scene before the next subscene can be added.

IP Addressing

What is an IP Address?

A full explanation of IP addressing is beyond the scope of this user guide. However, the 
following details provide enough information to get started.

An IP address is a 32-bit binary number that is used to identify each device on an Ethernet 
network. This number is usually represented by four decimal numbers (each in the range 
of 0 to 255) separated by dots, such as 198.123.34.240. This is called “dotted decimal 
notation.”
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An IP address is divided into two parts:

zz Network identifier

zz Host identifier

Each address on a given network must have the same network identifier value but have 
a unique host identifier. As a result, there are different classes of addresses the define the 
range of valid addresses and which parts of the address are used for the network and host 
identifiers.

The most common IP address classes are:

Class Name Valid Address Range Identifier Arrangement

Class A 0.0.0.1 to 127.255.255.254 NNN.HHH.HHH.HHH

Class B 128.0.0.1 to 191.255.255.254 NNN.NNN.HHH.HHH

Class C 192.0.0.1 to 223.255.255.254 NNN.NNN.NNN.HHH

NNN refers to the network identifier and HHH refers to the host identifier.

Choosing IP Addresses

If the Quantum Control Software computer and Quantum processors are directly connected 
or connected via their own independent network, follow the guidelines below for choosing 
the IP addresses.

However, if you intend to connect your computer and Quantum processors to an existing 
network, you need to advise the network administrator and ask the administrator to allocate 
suitable IP addresses.

On an independent network, it is generally recommended that you use the Class C format 
(from 192.0.0.1 to 223.255.255.254).

There are two rules for choosing IP addresses:

zz Network identifier must be the same for each IP address

zz Host identifier must be unique for each address.

Applying these rules to Class C addresses, the first three decimal values of your IP address 
must all be the same while the last value is used to uniquely identify each device.

The following is an example of a valid Class C addressing scheme:

Device IP Address

Quantum Control Software Computer 208.132.180.41

Quantum processor 1 208.132.180.42

Quantum processor 2 208.132.180.43

NOTE:	 The host identifiers (41, 42, and 43 in the above example) do not need to be 
sequential or in any particular order. However, it is recommended that you group 
the numbers for simplicity.
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The following is an example of an invalid Class C addressing scheme:

Device IP Address

Quantum Control Software Computer 208.132.180.41

Quantum processor 1 192.157.180.42

Quantum  processor 2 209.100.123.43

NOTE:	 The above addresses are invalid because the network identifier for each address 
is not the same even though each IP address is unique.

You can perform a test from your computer to check that a device at a particular address is 
responding correctly (see “Testing the Ethernet link”).

Subnet mask

The subnet mask is another 32-bit binary number that is used to “mask” certain bits of the 
IP address. This provides a method of extending the number of network options for a given 
IP address. It works by allowing part of the host identifier to be used as a subnet identifier.

It is important that you set the correct value for the subnet mask. The basic values depend 
on the class of IP address being used. 

Class Name Subnet Mask

Class A 255.0.0.0

Class B 255.255.0.0

Class C 255.255.255.0
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